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Pro Tools Menu (Macintosh Only)

Pro Tools Menu
(Macintosh Only)

The Pro Tools Menu commands include links to
Pro Tools Preferences, access to Mac OS X appli-
cation management, and the Quit command.

About Pro Tools
Preferences...

Services >
Hide Pro Tools 7.0

Hide Others

Show All

Quit Pro Tools 7.0 #Q

Pro Tools menu

About Pro Tools

The About Pro Tools command launches the
Pro Tools banner, which includes the version
number of your Pro Tools software.

Preferences

Pro Tools Preferences are available from both
the Pro Tools Menu and the Setup menu. For
more information, see “Preferences” on page 58.

Macintosh Application
Management Commands

(Services, Hide Pro Tools, Hide Others,
Show All)

The Pro Tools menu also provides access to the
following Macintosh OS X application manage-
ment commands: Services, Hide Pro Tools, Hide
Others, and Show All. For more information
about these and other Mac OS X features, refer
to your Apple Macintosh documentation.

Quit Pro Tools

The Quit Pro Tools command ends your
Pro Tools session and closes the Pro Tools appli-
cation.

Chapter 1: Pro Tools Menu (Macintosh Only)
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File Menu

File Menu

File menu commands are used to create and
maintain Pro Tools sessions.

Close Session CirHShift+ia)

Save CirH+s
Save As...

Save Copy In...

Revert 1o Saved...

Send via DigiDelivery...

Bounce to v

Impart 4

Export 4

Get Info...

Exit CHrl+G
File menu

New Session

The New Session command creates a new

Pro Tools session. Before the session is created,
you must name the session and choose its Audio
File type, Sample Rate, Bit Depth, and I/O Set-
tings in the New Session dialog.

Name the session: PE

Folders
Save in: [ 13 Audio Drive v Q s i
Save a3 type: Pro Tools Session [*.ptf] v|
Session Parameters
Audio File Type Sample Rate Bit Depth
;AIFF ~| 44.1 kHz v @16 Bit
140 Settings O 24 Bit
| Last Used v

New Session dialog

Chapter 2: File Menu 3



Open Session

The Open command opens a session previously
created with Pro Tools. Only one session can be
open at a time.

Close Session

The Close command closes the current session
without quitting Pro Tools. Pro Tools prompts
you to save changes before closing the session.

Save

The Save command saves changes made since
the last time the session was saved. You cannot
undo the Save command.

Save As

The Save As command lets you save a copy of
the current session under a different name, or in
a different location. Because the Save As com-
mand closes the current session and allows you
to keep working on the renamed copy, it is use-
ful for saving successive stages of the session.
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Save Copy In

The Save Copy In command lets you save a copy
of the currently selected session under a differ-
ent name or in a different location. Session me-
dia can be included in the copy that you save,
with options to save the media at a different bit
depth, sample rate, fader gain level, or file for-
mat type. Sessions can be saved in a variety of
session formats for compatibility with older sys-
tems. This command is useful for archiving ses-
sions.

Save copy of session in

Foldars:
Savein 3 Audio Diive ¥ OO
CiFiltered Dresm
File name: Copy of Fitered Dieari
Save aslps  pug Tocks Session [ pi] -

Sszion Parametess

sudoFleTips  SompleRate 81 Deplh
AFF 3 [aww: ) | DE5
4Bk

Fadet Gain

Trema o Copy
[0 A Files
[0 NorrAIFF ude Fies

[ Session Fhugdn Seltings Folder
] Aoot Phugdn Seffings Folda:
[ MovieAviden File:

Save Copy In dialog

Unlike the Save As command, Save Copy In does
not close the original session, so subsequent ed-
its are made to the original session. The saved
copy becomes a backup copy, and gives you the
option of returning to the earlier version.



When you Save Copy In with a lower bit rate,
Pro Tools Dither with Noise Shaping will be ap-
plied. The Dither setting used for any conver-
sion is the Digidesign Dither plug-in with Noise
Shaping enabled.

For information on sharing sessions be-
tween different platforms, Pro Tools sys-
tems, or Pro Tools software versions, see the
Pro Tools Reference Guide.

The Items To Copy section of this dialog pro-
vides several options for copying a session along
with its associated files.

All Audio Files When selected, all audio files are
copied to the new location. Selecting All Non-
“file type” Audio Files copies all audio files ex-
cept audio files of the specified audio file type.
This option’s file type will always be the default
audio file type of the session; so if the session’s
default audio file type is WAV, the option will
read All Non-WAV Audio Files. Selecting Don’t
Copy Fade Files omits fade files from the copied
data.

Session Plug-In Settings Folder When selected,
the session’s Plug-In Settings Folder is copied to
the new location. The references to these plug-
in settings in the session are redirected to the
copied files.

Root Plug-In Settings Folder When selected, the
contents of the root-level Plug-In Settings Folder
are copied into a folder named Place in Root Set-
tings Folder, indicating that these files will need
to be moved to the root level plug-in settings
folder on the destination system before you can
use them. The references to these settings files in
the session are not redirected to point to the cop-
ied files.

Movie/Video Files When selected, the session’s
video files are copied to the new location, and

the references in the session are redirected to the
copied movie or video file.

Revert to Saved

The Revert to Saved command restores the most
recently saved version of a session, discarding all
changes made since the last time you saved. Re-
verting to the last saved version of a session is
like closing the session without saving changes
and reopening it.

Chapter 2: File Menu
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Send via DigiDelivery

DigiDelivery is Digidesign’s system for efficient
and reliable transfer of digital media files over
the Internet. Send via DigiDelivery lets you send
a Pro Tools session and all of its related files us-
ing DigiDelivery from within Pro Tools.

Anyone can send and receive files from a Digi-
Delivery system, even if they do not own a Digi-
Delivery network appliance, as follows:

o To send a delivery, senders must have an In-
ternet connection, an account on a DigiDelivery
network appliance, and the DigiDelivery client
application.

o To receive a delivery, recipients only need an
Internet connection and the DigiDelivery client
application. An account on the network appli-

ance is not needed.

For more information about DigiDelivery,
see the DigiDelivery Guide.
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Bounce to Commands

The Bounce to commands let you mix tracks to-
gether into one file.

Bounce to Disk

The Bounce to Disk command allows you to mix
together the outputs of all currently audible
tracks routed to a common output path to create
anew audio file. You can use the Bounce to Disk
command to create a submix or to create a final
mix in any of several audio file formats.

Bounce =

Bounce Cptions

Bounce Source: | Out 1-2 (Sterea) '~

File Type: [ATFF -
Format: | Stereo Interleaved |~
Resolution:

Sample Rate: | 44100 B

Conversion Quality: | Tweak Head (Slowest) |-

{2 Convert During Bounce
() Convert After Bounce

[ Cancel ] [ Help... ] [Buunce...

Bounce to Disk dialog

Bounce Source Selects the audio output path to
bounce. Only audio routed to the selected path
will be included in the bounce.

Enforce Avid Compatibility Creates frame-accu-
rate edits, wraps the files as OMFI (unless File
Type is MXF), and limits the sample rate options
to 44.1 kHz or 48 kHz. Dithering without noise
shaping will be applied to files being exported
from 24-bit to 16-bit.



File Type Selects the audio file type. Choices on
all systems are BWF (WAV), AIFF, MPEG-1
Layer 3 (MP3), and QuickTime. Windows sys-
tems also include Windows Media (Windows).
Macintosh systems also include SD II and Sound
Resource. Systems with the DigiTranslator op-
tion also support MXF audio files.

Certain file types are restricted in regards to for-
mat, resolution, and sample rate.

Format Selects the channel format (number of
channels). Choices are mono (summed), multi-
ple mono, or interleaved.

Resolution Selects the bit depth. Choices are
24-bit, 16-bit, or 8-bit resolution.

Sample Rate Selects the sample rate.

Q Whenever a Bounce to Disk is configured to
" a different file type, file format, resolution,
or sample rate, additional options become
available to convert during or after the
bounce. See “Additional Bounce Options”
on page 7 for more information.

Import After Bounce Automatically imports the
audio after it is bounced and adds it to the Re-
gion List so that it can be used in the session.

A\ The Import After Bounce option is only
available if the target file type and sample
rate for the bounce are the same as the file
type and sample rate of the current session,
and the target resolution (bit rate) is the
same or lower than the resolution of the ses-
sion. In addition, tracks bounced to a Stereo
Interleaved file cannot be imported after a
bounce.

Additional Bounce Options

The following Bounce options are only available
when bouncing to a different file type, format,
resolution, or sample rate.

Conversion Quality Selects the quality, with op-
tion ranging from Low to Tweak Head, when
bouncing to a new sample rate.

Use Squeezer Optimizes the dynamics of the
bounced audio before conversion to 8-bit reso-
lution.

Convert During Bounce Automatically performs
file type, sample rate, and bit resolution conver-
sion as the file is being bounced.

Convert After Bounce Automatically performs
file type, sample rate, and bit resolution conver-
sion after the file has been bounced.

Bounce to QuickTime Movie

This command compiles a new QuickTime
movie with the current session as the audio
soundtrack. Pro Tools will convert the audio
tracks to the selected sample rate and bit resolu-
tion, then create a new flattened movie with the
bounced audio. As a QuickTime file, the new
movie is supported by all software applications
that support QuickTime video.

Chapter 2: File Menu



Import

Pro Tools provides several menu commands to
import files and regions into an open session.

Import Session Data

This command lets you import selected session
data from an existing session into the current
session. Options are provided for time code
mapping, track offset options, sample rate con-

version, and copying, converting, and referenc-
ing audio and video source files. The Import Ses-
sion Data command also lets you import the
Tempo Meter Map and any Markers/Memory
Locations.

With Pro Tools HD, you can select specific ses-
sion data (such as automation and routing) to
import. You can also import main playlist op-
tions—either replacing existing options or over-
laying elements onto existing tracks.

Import Session Data

Source Properties

Time Code Mapping Options

Name: Filtered Dream

[Maintain absalute time code values | -]

Type: Current Session
Created by: Pro Tools LE/Windows v7.0.0.128 |
Start time; 00:00:00:00

el

—
o:00.000 |

Time code format: 29,97

Audio bit depth(s): 16 Track Offset Options
Audio sample rate(s): 44100 Offset Incoming Tracks to:
fudci el dty | 1| 1] 000 | [Bars:Beam v]

Audio Media Options

Sample Rate Conversion Options

[Copy from source media ‘] [Japply sRC
Video Media Options

Source Tracks Destination
Lead Guitar {Mono audia) [{none) -4
R Guitar F¥ (Stereo audio) [inone) -]
Guitar F¥ {Stereo aux) [(none) ']
Bass Guitar {Mono audio) [{none) ']
Comb Bass (Mono audio) [{none) '] 1
Drum Edit (Stereo audia) [(none) ']
Redrum Bne (Stereo audio) [{nune) ']
Percussion (Stereo audio) [ {rone) Rals
Import:

Tempo/Meter Map

[IMarkers/Memory Locations

Cancel ] [ 0K

Figure 1. Import Session Data dialog
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Import Region Groups

This command loads region groups into the Re-
gion List without creating a new track.

Import Audio to Track

This command loads audio files or regions into
the current session. Each imported audio file
will appear on its own individual track.

Import Audio to Region List

This command lets you import audio into the
Region List without automatically creating new
tracks.

Import Audio from Current Movie

This command imports audio directly from a
QuickTime movie currently loaded into a ses-
sion. Pro Tools will convert the audio to the cur-
rent session sample rate and bit resolution.

Import Audio from QuickTime Movie

This command imports audio from a QuickTime
movie on your hard drive. If necessary,

Pro Tools will convert the audio to the current
session sample rate and bit resolution. This
command can also be used to import audio files
from audio CDs.

Import MIDI to Track

The Import MIDI to Track command imports all
tracks from a Standard MIDI file into Pro Tools
and automatically places them in new MIDI
tracks.

Options are provided for importing the Session
Start or Song Start Marker (if the marker is not
located at the session start), importing tempo
map data contained in the sequence, and re-
moving existing Instrument or MIDI tracks.

Import MIDI to Region List

This command imports all tracks from a Stan-
dard MIDI file into Pro Tools without automati-
cally creating new tracks for them. Imported
tracks appear in the Region List and can then be
dragged into a MIDI track.

Options are provided for importing the Session
Start or Song Start Marker (if the marker is not
located at the session start), importing tempo
map data contained in the sequence, and re-
move existing Instrument or MIDI tracks.

Import QuickTime Movie

(Pro Tools Systems without an Avid DNA Video
Peripheral Only)

This command imports a QuickTime movie into
the current session. Once imported, the Quick-
Time movie is displayed in its own Movie track
in the Edit window, and in a floating Movie
window. With a QuickTime movie in a session,
Pro Tools serves as a fast, random-access visual
reference for “sweetening” the movie by adding
sound effects, music, Foley, dialog, or other au-
dio.

Import Avid Movie or QuickTime Movie

(Pro Tools HD with an Avid DNA Video
Peripheral Only)

This command imports a QuickTime movie (or
Avid Video) into the current session. Once im-
ported, the QuickTime movie (or Avid Video) is
displayed in its own Movie track in the Edit win-
dow, and in a floating Movie window. With a
QuickTime movie (or Avid Video) in a session,
Pro Tools serves as a fast, random-access visual
reference for “sweetening” the movie by adding
sound effects, music, Foley, dialog, or other au-
dio.

Chapter 2: File Menu



Export

Pro Tools provides several menu commands to
export session tracks or data as files.

Export Selected Tracks as OMF/AAF
(DigiTranslator Option Only)

The Export Selected Tracks as OMF command

exports selected tracks in AAF and OMFI format.

Advanced Authoring Format (AAF) and Open
Media Framework Interchange (OMFI) are in-
dustry standard file formats that facilitate the
transfer of digital media between applications
(such as Pro Tools and Avid Video editing soft-
ware). If the DigiTranslator option is not in-
stalled, the Export Selected Track as OMF com-
mand will be greyed out in the File menu.

For more information, see the DigiTransla-
tor 2.0 Integrated Option Guide.

Export MIDI

This command exports all currently audible
MIDI tracks in a session as a standard MIDI file.
Muted MIDI tracks will not be exported. You
can export the file as a Type 1 (multitrack) or
Type 0 (merged) Standard MIDI file.

Export Session Info as Text
(Pro Tools HD Only)

This command exports the current session as a
tab-delimited text file that can contain region
and file names, extended timestamp informa-
tion, and information about crossfades.

10 Pro Tools Menus Guide

You can export to any of several different text
file formats (including Microsoft Word and Ex-
cel).

Export Session Text

Include File List
Indlude Region List
Include Track EDL's

[]show Subframes

[Jindude User Timestamps
Fade Handling

(%) Show Crossfades

() Don't Show Crossfades

() Combine Crossfaded Regions

Time Format:

[Mins:Secs -]

Export Session Info as Text dialog

Get Info

This command lets you enter and save informa-
tion about the session.

Left-column text fields are topic fields. Text en-
tered there is saved with your Pro Tools Prefer-
ences and will appear in all sessions, allowing
you to preset the field to topics that you com-
monly use.

Right-column text fields are information fields
and are session specific and will be saved with
the session.

Exit
(Windows Only)

The Exit command ends your Pro Tools session
and closes the Pro Tools application.



Edit Menu

Edit Menu

Edit menu commands are used to edit and ma-
nipulate the current selection and affect data in
the timeline.

View Track Region Event Auw
himdati el

Undo At Selection EA
Can't Redo rIEZ7
Cut 3EX
Copy 38C
Paste £
Clear #B
Cut Special b
Copy Special b
Paste S pecia

Clear Special >
Select All FEA
Selection >
Duplicate #D
Repeat... R
Shift... XH
Insert Silence 4t 38E
Trim Region B
Separate Region 4
Heal Separation #H
Strip Silence #EU
Consolidate A3
TCE Edit to Timeline Selection iU
Automation >
Fades b

Edit menu

Undo

The Undo command lets you sequentially undo
up to 32 of your previous actions. Certain com-
mands and actions (such as saving) are not un-
doable. The last command in the undo queue
will appear in the menu (for example, “Undo
Paste”).

Redo

After undoing a command or action, you can
redo it by choosing the Redo command. This is
a good way to compare before and after states of
edits.

Cut

This command cuts a selection out of its current
location and stores it in memory so that you can
paste it elsewhere.

Copy

This command copies a selection (leaving the
original intact) and stores it in memory so that
you can paste it elsewhere.

Paste

This command inserts cut or copied data into a
location specified with an Edit tool (such as the
Selector tool).

Chapter 3: Edit Menu
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Clear

This command removes the contents within a
selection in the Edit window.

Cut Special

The Cut Special commands let you cut just auto-
mation data from the current selection (without
associated audio or MIDI notes) and place it in
memory to paste elsewhere. Choices include:

All Automation Cuts all automation or MIDI
controller data whether it is shown or not.

Pan Automation Cuts only pan automation or
MIDI pan data whether it is shown or not.

Plug-In Automation Cuts only plug-in automa-
tion that is shown.

Copy Special

The Copy Special commands let you copy just
automation data from the current selection
(without associated audio or MIDI notes) and
place a copy of it in memory to paste elsewhere.

All Automation Copies all automation or MIDI
controller data whether it is shown or not.

Pan Automation Copies only pan automation or
MIDI pan data whether it is shown or not.

Plug-In Automation Copies only plug-in automa-
tion that is shown.

Paste Special

The Paste Special commands let you paste auto-
mation data into another region (without affect-
ing associated audio or MIDI notes) in the fol-
lowing ways:

12 Pro Tools Menus Guide

The Paste Special commands let you paste auto-
mation data into another region (without affect-
ing associated audio or MIDI notes) in the fol-
lowing ways:

Merge Pastes MIDI controller data from the clip-
board to the selection and merges it with any
current MIDI controller data in the selection.
This can be useful for consolidating MIDI data
from several tracks into a single MIDI track.

Repeat to Fill Selection Pastes multiple itera-
tions of audio or MIDI data from the Clipboard
to fill the selection. If you select an area that is
not an exact multiple of the copied region size,
the remaining selection area is filled with a
trimmed version of the original selection. This
allows you to easily create drum loops and other
repetitive effects. Before the data is pasted,

Pro Tools prompts you to specify a crosstade to
smooth transitions between regions.

To Current Automation Type Pastes the automa-
tion or MIDI controller data from the clipboard
to the selection as the current type of automa-
tion or continuous MIDI data. This lets you
copy one type of automation data to another, or
one type of continuous MIDI date to another
type of contiguous MIDI data.

Clear Special

The Clear Special commands let you clear just
automation data from the current region.
Choices in the Clear Special submenu are All
Automation, Pan Automation, and Plug-In
Automation.



Select All

This command selects all audio and MIDI data
in one or more tracks.

o To select all regions in a single track, select a
portion of the track, or click the Selector any-
where in a track and choose Select All.

o To select all regions on multiple tracks, Shift-
click a region on each track with the Selector or
Grabber and choose Select All.

0 To select all regions on all tracks, Select the
“All” Edit Group in the Groups List, click the Se-
lector anywhere in a track, and choose Select
All

Selection
(Pro Tools HD Only)

The Selection commands are for copying or
playing Edit or Timeline selections.

Change Timeline to Match Edit

When the Edit and Timeline selections are un-
linked, this command copies the current Time-
line selection to the an Edit selection.

Change Edit to Match Timeline

When the Edit and Timeline selections are un-
linked, this command copies the current Edit se-
lection to the Timeline.

Play Edit
(Pro Tools HD Only)

This command plays an Edit selection.

Play Timeline
(Pro Tools HD Only)

This command plays a Timeline selection.

Play Edit Selection
(Pro Tools LE and M-Powered Only)

This command plays an Edit selection.

Duplicate

This command copies a selection and places it
immediately after the end of that selection in a
track.

Repeat

This command is similar to Duplicate, but al-
lows you to specify the number of times the se-
lected material is duplicated. To use this com-
mand, select the material you want to repeat,
choose Repeat, then enter the number of repeti-
tions.

Shift

This command moves track material earlier or
later in time by a specified amount. To use this
command, select the material you want to
move, choose Shift, then enter the desired direc-
tion and time value.

Insert Silence

This command creates regions of silence. Make a
selection on one or more tracks, choose Insert
Silence, and precisely that amount of silence
will be inserted.

Trim Region

This command provides several options for edit-
ing region boundaries (including looped re-
gions).

Chapter 3: Edit Menu
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To Selection

This command removes data before and after a
region or MIDI note selection, leaving only the
selection. This command lets you quickly re-

move all data in a region (and in some instances
the entire track) except for the current selection.

Start to Insertion

This command lets you trim a region or MIDI
note by automatically removing the material be-
tween the Edit insertion point and the start
point.

End to Insertion

This command lets you trim a region or MIDI
note by automatically removing the material be-
tween the Edit insertion point and the end
point.

Start to Fill Selection

This command lets you automatically reveal un-
derlying material in the gaps between the region
start and selection start points.

End to Fill Selection

This command lets you automatically reveal un-
derlying material in the gaps between the selec-
tion end and region end points.

To Fill Selection

This command lets you automatically reveal un-
derlying material in the gaps before and after
the selection.
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Separate Region

These commands separate a region from adja-
cent data in the track where it was created. By
separating a region you will also create by-prod-
uct regions from data on either side of the sepa-
ration.

Q The Separate Region commands automati-
" cally unloop and flatten looped regions be-
fore separating.

At Selection

This command creates new region boundaries at
the selection start and end points.

On Grid

This command constrains newly created regions
to start and end on grid points.

At Transients

This command automatically creates region
boundaries on detected transients within a se-
lection.

Heal Separation

This command repairs separated regions, pro-
vided that the regions are contiguous and their
relative start and end points haven’t changed
since they were originally separated. If you have
trimmed or changed the start and end points of
the two regions, or moved them away from each
other, they cannot be repaired with the Heal
Separation command.



Strip Silence

This command opens the Strip Silence window.
Use this window to remove areas of silence from
a selection. Strip Silence automatically divides a
selection into regions, which can be useful for
quantizing audio to musical values or SMPTE lo-
cations.

L L ——

1 31117 Dt o P —

Weiparn Seat Pk

Region End Fad

Strip Silence window

Consolidate

This command consolidates multiple regions
into a single region. When an audio track is con-
solidated, a new audio file is written that en-
compasses the selection range, including any
blank space or fades.

TCE Edit to Timeline Selection
(Pro Tools HD Only)

This command uses the Time Compression/Ex-
pansion plug-in to fit an audio selection to a
Timeline selection. This is only possible when
the Edit and Timeline selections are unlinked.

Thin Automation
(Pro Tools LE and M-Powered Only)

This command lets you selectively thin areas in
a track where automation data is too dense and
adversely affecting CPU performance. The
amount of thinning performed is determined by
the amount you have selected in the Automa-
tion page of the Preferences dialog. Avoid over-
thinning data or it may no longer accurately re-
flect the original automation.

Automation
(Pro Tools HD Only)

With Pro Tools HD, multiple Automation com-
mands are available.

Copy to Send

This command lets you copy either the current
values or automation of a selected track’s vol-
ume, pan, mute, or LFE automation to the cor-
responding playlist for the send. This is useful
when you want a track’s send automation to
mirror automation on the track itself.

Copy To Send

Copy: ™ current value
] Automation
From: E Volume
 pan
I Mute
O wre
To: | Send A I-a]
...of all selected tracks
{ cancel \ ('—OK—")
Copy to Send dialog

To copy a track’s current control settings to a
send on that track, select Current Value. To
copy the entire automation playlist for the track
to a send, select Automation.

Chapter 3: Edit Menu
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Thin Automation

This command lets you selectively thin areas in
a track where automation data is too dense and
adversely affecting CPU performance. The
amount of thinning performed is determined by
the amount you have selected in the Automa-
tion page of the Preferences dialog. Avoid over-
thinning data or it may no longer accurately re-
flect the original automation.

Write to Current and Write to All
Enabled

These commands let you write automation
states for one or more parameters to specific ses-
sion locations in a single step. This saves you the
trouble of performing multiple automation
passes for different parameters in real time, or
having to graphically draw automation state
changes on individual automation playlists.

Write to Current Parameters

This command writes the current value only to
the currently displayed automation parameter.

Write to All Enabled Parameters

This command writes the current settings for all
automation parameters enabled in the Auto-
mation Enable window.
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Trim to Current and Trim to All Enabled

These commands let you use trim values as
snapshots and apply the relative changes or
delta values to the selected automation. This is
similar to the Write Automation command, ex-
cept that it writes delta values instead of abso-
lute values to automation data. You can use trim
values in writing snapshot automation to any
automatable parameter.

Trim to Current Parameter

This command trims the current value only to
the currently displayed automation parameter.

Trim to All Enabled Parameters

This command trims the current settings for all
automation parameters enabled in the Auto-
mation Enable window.

Glide to Current and Glide to All
Enabled

These commands let you manually create an au-
tomation transition (or glide) from an existing

automation value to a new one, over a selected
area.

Q Glide Automation can also be used for au-
tomating the Surround Panner.

Glide to Current Parameter

This command applies Glide Automation only
to the currently displayed automation parame-
ter.

Glide to All Enabled Parameters

This command applies the Glide Automation
for all automation parameters enabled in the
Automation Enable window.



Fades

These commands let you create (or delete) a
crossfade between two adjacent audio regions,
or a fade-in or fade-out of a single region. Cross-
fade duration, position, and shape are all select-
able. A selection that crosses multiple regions
will create crossfades for each of the region tran-
sitions. If a selection includes regions that al-
ready contain crossfades, the existing crossfades
will be modified.

Fades

E-'

QOut Shape <<= Link =>> In Shape
@ Standard O Equal Power @ Standard
@ Equal Gain ) s-Curve
) None
™ Use Dither

Cancel

Fades dialog

Create

The Create command produces a crossfade be-
tween adjacent regions according to parameters
you specify with the Fades editor.

Delete

The Delete command removes a crossfade be-
tween adjacent regions.

Fade to Start

The Fade to Start command creates a fade-in
from the current insertion point to a region’s
start point.

Fade to End

The Fade to End command creates a fade-out
from the current insertion point to a region’s
end point.

Chapter 3: Edit Menu
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chapter 4

View Menu

View Menu

View menu options and commands control the
display of Pro Tools windows, tracks, and track
data. Some View menu options toggle the dis-
play of various Pro Tools windows or data: se-
lecting the option displays the data, and dese-
lecting the option hides the data.

Marrow iy Cir At
iz Window »
Edit Winidow [
Fulers »
Region [
Sends A-E »
Sends F-1 »
Track Mumber

Transport L
Disk Space »
Main Counter L4

View menu

Narrow Mix

This option reduces the width of Mix channels
on-screen, allowing you to display the maxi-
mum number of tracks on your computer mon-
itor. In this view, track names, names of sends,
and plug-in names are abbreviated to accommo-
date the smaller view. To return to normal view
width, choose this command again.

Mix Window

These options selectively display Mic Preamps
(Pro Tools HD only), Instruments, Inserts, Sends
A-E, Sends F-J, Delay Compensation (Pro Tools
HD only), Track Color, and Comments views in
the Mix window. You can also select All of the
displays, or None of them.

Edit Window

These options selectively display Comments,
Mic Preamps (Pro Tools HD only), Instruments,
Inserts, Sends A-E, Sends F-J, I/O, Real-Time
Properties, Track Color, and Transport views in
the Edit window. You can also select All of the
displays, or None of them.
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Rulers

These options selectively display various Time-
base and Conductor rulers in the Edit window.
In addition to providing a timing reference for
track material, Timebase rulers are used to de-
fine Edit and Timeline selections.

Besides selecting individual rulers, you can se-
lect All of the rulers, or None of them.

Timebase Rulers

Any or all of the following Timebase rulers can
be displayed at the top of the Edit window:
e Bars:Beats
¢ Minutes:Seconds
e Time Code (Pro Tools HD and Pro Tools LE
with DV Toolkit only)
e Feet+Frames (Pro Tools HD and Pro Tools
LE with DV Toolkit only)
e Samples

In addition to providing a timing reference for
track material, the Timebase rulers are also used
to define Edit selections for track material, and
Timeline selections for record and play ranges.

%

<

With the Selector, drag in any Timebase
ruler to select material across all tracks in
the Edit window. To include the Conductor
Tracks in the selection, press Alt (Windows)
or Option (Macintosh) while dragging.
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Conductor Rulers

Any or all of the following Conductor rulers can
be displayed:

* Markers

e Tempo (and Tempo Editor)

e Meter

The Meter and Tempo rulers indicate changes in
meter and tempo within the Session. The Mark-
ers ruler displays Markers to important track lo-
cations.

The Tempo Editor is an expansion of the Tempo
ruler, opening in the rulers section of the Edit
window.

Region

Sync Point

This option lets you display or hide sync points
in regions. Regions will align to a sync point re-
gardless of its display status.

This option lets you display or hide a region’s
name in tracks in the Edit window. Hiding a dis-
play is useful if you are working at a zoom level
where region names obscure the view of audio
waveforms.

Overlap

This option lets you display or hide the region
overlap “dog-ear” corner that indicates overlap-
ping region boundaries.

Current Time

This option displays the time stamp of all re-
gions placed in all tracks according to their cur-
rent location in the track.



Original Time Stamp

This option displays the Original Time Stamp of
all regions in all tracks. When a region is cre-
ated, it is time stamped relative to the SMPTE
start time specified for the session. This original
time stamp is permanently stored with the re-
gion and cannot be changed. If a region is ever
moved, it can easily be placed at its original po-
sition using the Spot dialog.

User Time Stamp

This option displays the User Time Stamp of all
regions in all tracks. When a file is first recorded,
its User Time Stamp is identical to its original
time stamp. You can change the User Time
Stamp using the Time Stamp Selected command
in the Region List. This allows you to use a cus-
tom time stamp for spotting or re-spotting the
region to a time location different from its Orig-
inal Time Stamp.

No Time

This option disables the time stamp display in
regions.

Sends A-E

These options display either send assignments
for all sends, or the controls for individual sends
(Sends A-E). Select Assignment to display all five
of these send assignments.

Sends F-J

These options display either send assignments
for all sends, or the controls for individual sends
(Sends F-J). Select Assignment to display all five
of these send assignments.

Track Number

This command assigns each track a number cor-
responding to its position in the Mix and Edit
windows. When tracks are reordered, track
numbers stay in positional sequence.

Transport

These options selectively displays Counters,
MIDI Controls, and Expanded controls in the
Transport window.

System Usage
(Pro Tools HD Only)

These options set the display format for the Sys-
tem Usage window: Small, Large, Detailed, Gas

Gauge, or Activity Only. The System Usage win-
dow shows the usage of DSP and CPU resources

during a session.

Disk Space

These options specify either a Text or Gas Gauge
style display format for the Disk Space window.
The Disk Space window shows how much re-
cording time is currently available on each hard
drive connected to your system.

Main Counter

These view options set how the Time Scale is dis-
played in the Main Counter.

Bars:Beats

This option displays the Time Scale in Bars and
Beats. Use this Time Scale if you are working
with musical material that must align with bars
and beats.
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Minutes:Seconds

This option displays the Time Scale in minutes
and seconds.

Time Code

(Pro Tools HD and Pro Tools LE with DV Toolkit
Only)

This option displays the Time Scale in SMPTE
frames. The Frame Rate and Session Start time
are set from the Session Setup window.

Pro Tools supports the following frame rates: 24,
25, 29.97 Non-Drop, 29.97 Drop, 30 Non-Drop,
and 30 Drop frames per second.

Feet+Frames

(Pro Tools HD and Pro Tools LE with DV Toolkit
Only)

This option displays the Time Scale in feet and
frames for referencing audio-for-film projects.
The Feet+Frames time display is based on the 35
millimeter film format.

Samples

This option displays the Time Scale in samples.
This format is useful for high-resolution sample
editing.
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Track Menu

Track Menu

Track menu commands are used to create, man-
age, and edit tracks.

Region Event

AudioSuite Op

New... {+38N
Group... #G
Duplicate... GD
Split into Mono
Make Inactive
Delete...
Write MIDI Real-Time Properties
Avid Video
Set Record Tracks to Input Only K
Scroll to Track... HEF
Clear All Clip Indicators s
Track menu
New Track

The New Track command lets you add one or
more new audio tracks, Auxiliary Inputs, MIDI
tracks, Master Faders, or Instrument tracks to a
session.

Audio tracks, Auxiliary Inputs, and Master fad-
ers can be mono or stereo, or a greater-than-ste-
reo multichannel format (Pro Tools HD only).

Mew Tracks

B o [sameies 9 '

Cancal ) (A

Create [ mew [ Momo | [ wuda T

New Track dialog

This command groups the currently selected
tracks together so that their controls are linked
together in either or both the Mix and the Edit
window. Groups can be nested so that sub-
groups are contained within larger groups.

New Croup

Name for group: Group 1

) Edit
Group Type. C Mix
® Edit And Mix

=

Group ID: ' a %

o>

(" Cancel )

Group Selected Tracks dialog
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Duplicate

This command lets you define how many copies
of a track you want to create, and specifies
whether to copy audio or MIDI data, playlists,
automation, and other attributes.

When duplicating multiple tracks, you can also
choose to have the new tracks follow the last se-
lected track (or have each new track follow its
source track).

Split Into Mono

This command splits a selected stereo or multi-
channel track into individual mono tracks that
can be edited and manipulated independently.
The Split Into Mono command cannot be un-
done.

Make Inactive or Make Active

This command makes selected tracks inactive,
so that they no longer play back or use any DSP
resources or voices. Inactive tracks can be made
active again by choosing the Make Active com-
mand.

Delete

This command removes tracks from a session.
While audio or MIDI region data will remain in
the Region List, the track and its arrangement of
the regions on the deleted track (the track’s
playlist) will be lost.

If the track contains playlists that are not as-
signed to any track, you will be prompted to de-
lete or retain them.
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Write MIDI Real-Time Properties

This command applies MIDI quantization, dura-
tion, delay, velocity, and transposition parame-
ters during playback, as set in Real-Time Proper-
ties View (in the Edit window) or in the MIDI
Real-Time Properties dialog.

Avid Video

(Pro Tools HD with Avid DNA Video Peripherals
Only)

Avid Video commands are used for adding video
tracks and other audio formats to a session, and
managing movie playback.

New Track

This command creates a new empty movie track
into which you can record or import Avid video.

Add Video

This command adds additional movie clips to
the Video track. You will be prompted to spot
the clip to a SMPTE location. If the clip is spot-
ted to a location that already contains a movie
clip, the first clip will be truncated.

Undo Add Video

This command undoes the Add Video com-
mand and other Movie track editing functions
such as moving, copying, or clearing clips.
These actions cannot be undone by choosing
the standard Undo command from the Edit
menu.



Clear Selection

This command clears a selection in the Video
track. This allows simple editing of movie clip
content.

Clear Track

This command clears the entire Video track.

Set Scrub Window Size & Location

This command lets you store the current size
and location of the Pro Tools Movie window.

Use Scrub Window

This command opens a Scrub window, which
displays the Avid video at quarter-resolution,
but accurately scrubs the video. When the Scrub
window is open, video output alternates auto-
matically between the Scrub window and the
video reference monitor depending on whether
or not you are scrubbing.

When scrubbing, the video reference monitor is
black. When leaving Scrub mode, the Scrub win-
dow disappears and video is routed to the video
reference monitor.

A\ The Scrub window is only available in
Pro Tools systems with a Digidesign-quali-
fied Avid DNA video peripheral (such as
AVoption|V10 or Mojo), and when there is
Avid video in the Movie track. There is no
Scrub window for QuickTime video.

Set Record Tracks to Input Only
(Pro Tools HD Only)

This command changes all record enabled
tracks to monitor audio input only, regardless of
any punch in or out selection.

Set Record Tracks to Auto Input
(Pro Tools HD Only)

This command changes all record enabled
tracks to automatically switch from monitoring
input signals to monitoring recorded tracks.
When set, record enabled tracks monitor audio
input when the transport is stopped. When
playback is started for a punch-in, Pro Tools
monitors existing track material up until the
punch point. While punched in, the input sig-
nal is monitored. On punch-out, monitoring
switches back to the existing track material. This
is similar to the auto-switching logic found on
digital and analog multitrack tape machines.

Auto Input Monitoring
(Pro Tools LE and M-Powered Only)

In this mode, when session playback is stopped,
Pro Tools monitors audio input. When playback
is started for a punch-in, Pro Tools monitors ex-
isting track material up until the punch point.
While punched in, the input signal is moni-
tored. On punch-out, monitoring switches back
to the existing track material. This is similar to
the auto-switching logic found on digital and
analog multitrack tape machines.

Input Only Monitoring
(Pro Tools LE and M-Powered Only)

In this mode, when a track is record-enabled,
Pro Tools monitors audio input only, regardless
of any punch in or out selection.
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Scroll To Track

This command lets you scroll directly to any
track by position number. The Edit window
tracks will scroll to bring the selected track to as
close to the top as possible, and the Mix window
tracks will scroll to bring the selected track as
close to the left as possible.

Clear All Clip Indicators

This command clears all clip indication from all
meters.
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chapter 6

Region Menu

Region Menu

Region menu commands are used to manage
and edit regions.

Feqgion
Mute nmute Cir [+
LockAnlock Cirl+L
Send to Back Alt+Shift+B
Bring to Front Al+Shift+F
Eroup Cir H-AlHG
Loop... CrH-altL
Remaove Sync Point Cirl+,
Duantize to Grid Cirl+0

Region menu

Mute/Unmute Region

This command mutes playback of a selected re-
gion. Choosing the Unmute command unmutes
the region. This command does not create auto-
mation data.

Lock/Unlock Region

This command locks a selected region in place
so it cannot be moved unless you unlock it. This
command is useful for permanently associating
a region with a particular location in a track
(such as a beat, SMPTE frame, or time value). A
small lock icon appears in the region indicating
it has been locked.

Send to Back

This command sends the selected region or re-
gions behind any neighboring overlapping re-
gions. If multiple overlapping regions are se-
lected, Pro Tools will apply the command to
each region as that region relates to the neigh-
boring region on the right.

Bring To Front

This command brings the selected region or re-
gions to the front of any neighboring overlap-

ping regions. If multiple overlapping regions are
selected, Pro Tools will apply the command to

each region as that region relates to the neigh-
boring region on the right.

Chapter 6: Region Menu
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Group

The Group command creates a region group
from all elements in the current selection. Selec-
tions can include audio and MIDI regions on
one or more tracks. Multiple region groups can
be selected and included in new region groups.

Ungroup

The Ungroup command unpacks the currently
selected region group, revealing all underlying
regions and any nested region groups. When
there are multiple nested region groups, the Un-
group command will ungroup the front-most
top-layer region group only, preserving any un-
derlying region groups.

Q You can also use the Region > Ungroup
command on looped regions to unloop and
maintain all loop iterations as individual
regions.

Ungroup All

The Ungroup All command removes all layers of
region groups and nested region groups in the
currently selected region in one step.

Q You can also use the Region > Ungroup All
© command on looped regions to flatten the
looped regions into one region.
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Regroup

The Regroup command undoes the last Un-
group command and regroups the individual re-
gions back to their former region group state.
This lets you ungroup a grouped region, edit its
underlying regions in any way desired, and re-
group it to continue working on higher-level
composition and arranging.

Loop

The Loop command lets you loop audio and
MIDI regions.

Unloop

The Unloop command lets you switch looped
regions back to standard (unlooped) regions so
that they can be edited individually.

Rename Region

This command lets you rename selected regions.

When you rename a whole-file audio region,
you can specify whether to rename just the re-
gion, or both the region and the disk file.

Capture Region

This command defines a selection as a new re-
gion and adds it to the Region List. From there
the new region can be dragged into a track. You
cannot capture selections across multiple re-
gions unless the data is contiguous material
from the same file.



Identify Sync Point and Remove
Sync Point

This command places a Sync Point at the cur-
rent cursor location. When you identify a sync
point, a small down arrow appears at the bot-
tom of the region, with a vertical, light grey line
indicating the location of the sync point. This
Sync Point can then be used as the reference
point—nudge, spot, move, and so on—instead
of the region start or end. With Pro Tools HD,
when you choose this command, the current
SMPTE time is automatically entered as the
SMPTE location for the Sync Point.

To remove a Sync point from a region, select the
region with the Grabber and choose Region >
Remove Sync Point.

Quantize to Grid

This command adjusts the placement of a se-
lected audio or MIDI region in a track so that its
start point (or Sync Point, if it contains one) pre-
cisely aligns to the nearest Grid boundary. Grid
units are chosen from the Grid pop-up menu in
the Edit window.
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Event Menu

Event Menu

The Event menu contains commands for editing
audio and MIDI events.

AudinSuite Options S

| P
Time b
Tempo [
MIDI L3
MIDI Event List =

MIDI Track Offsets
MIDI Real-Time Properties

Remove Du pticatt‘: MNotes

Beat Detective 3£ (E
Identify Beat... 3£l
Renumber Bars...

All MIDI Notes Off {1 36.

T ————————————
Event menu

Time

Pro Tools provides several commands for defin-
ing meter and time over a range of time (or mea-
sures). The Time options include:

Operations Window

This command opens the Time Operations win-
dow. This floating window lets you define
meter, click, and song start options by choosing
any of the following commands from the pop-
up menu at the top of the window:

e Change Meter

e Insert Time

e Cut Time

* Move Song Start

(&) Time Operations

{ Change Meter s )
New Meter 47 4 click J
& apply change to: [ selected range | C]

25 bars of 4/4 to

Starting at bar:

Change 25 bars of 4/4

Realign:
O Meter ruler only
® Meter & tempo rulers,
all tick-based markers & tracks, and

LAl 1'#] sample-based markers & tracks

Chnoly )

Time Operations window, Change Meter option
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Change Meter

The Change Meter command lets you specify
complex meter changes for Bar|Beat-based mate-
rial. You can enter meter changes at a particular
bar, make a meter change over a selected area of
time, or add meter changes sequentially one bar
at a time.

(&) Time Operations

— Change Meter v

New Meter: 47 4 click: II'
Starting at bar: 8 apply change to: | selected range B‘

Change 25/ bars of 4/4 to 25| bars of 4/4

Realign:
O Meter ruler only
@ Meter & tempo rulers,

all tick-based markers & tracks, and

All % | sample-based markers & tracks

(Avply )

Time Operations window, Change Meter option
Insert Time

The Insert Time command lets you insert an
amount of blank time into conductor rulers,
MIDI tracks, and audio tracks.

(&) Time Operations

— Insert Time

Start End Length
00:00:11:17 | 00:00:55:00 00:00:43:06

! Set Meter: 4/ 4 Click: J

Realign:

; Meter ruler anly

® [Both 9‘ meter & tempo
All % | tick-based markers & tracks, and
Al % | sample-based markers and tracks.

Chply )

Time Operations window, Insert Time option
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Cut Time

The Cut Time command lets you cut a specified
amount of time from conductor rulers, MIDI
tracks, and audio tracks.

[&] Time Operations
— Cut Time )

U R
Start End Length
00:00:11:17  00:00:55:00 00:00:43:06

Realign:

_/ Meter ruler only

® Both B‘ meter & tempo

All + | tick-based markers & tracks, and

All % | sample-based markers and tracks.

Choly )

Time Operations window, Cut Time option
Move Song Start

The Move Song Start command lets you redefine
the location of the Song Start Marker.

&) Time Operations
—Move Song Start |3}
Move start to: 0:11.753
) Renumber 1st bar to: 1
Move:

; Song start only
e Song Start, meter & tempao rulers,

all tick-based markers & tracks, and

Mo B‘ sample-based markers & tracks.

Time Operations window, Move Song Start option



Tempo

Pro Tools provides several commands for defin-
ing tempo events over a range of time (or mea-
sures). The Tempo commands include:

Operations Window

This command opens the Tempo Operations
window. This window lets you define tempo
events over a range of time (or measures) by
choosing any of the following commands from
the pop-up menu at the top of the window:

¢ Constant

e Linear

e Parabolic

¢ S-Curve

* Scale

e Stretch

(&) Tempo Operations

- Constant |"¢3|

[} Advanced

Start End
17| 3| 125 17| 3] 125

Selection:

Tempao: 1z0.0000

_! Preserve tempo after selection

Apply

Tempo Operations Window

Constant

This command lets you create a constant tempo
over a selected range of time.

Linear

This command lets you create tempos that
change evenly over a selected range of time.

Parabolic

This command lets you create tempos that ac-
celerate or decelerate following a tempo curve,
which changes the tempo more rapidly or less
rapidly over the selection time.

S-Curve

This command lets you create tempos that ac-
celerate or decelerate following a tempo curve
with a definable breakpoint that determines
mid-curve times and tempo values.

Scale
This command lets you scale tempos within the
selection by a percentage amount.

Stretch

This command lets you select a region of tempo
events and apply them to a larger or smaller se-
lection area.
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Pro Tools provides several commands for chang-
ing MIDI data over a range of time (or mea-
sures). The MIDI commands include:

Operations Window

This command opens the MIDI Operations win-
dow. This floating window lets you configure
specific MIDI data by choosing any of the fol-
lowing commands from the pop-up menu at the
top of the window:

e Grid/Groove Quantize
e Restore Performance
e Flatten Performance
e Change Velocity

e Change Duration

e Transpose

e Select/Split Notes

e Input Quantize

e Step Input

8] MIDI Operations

[ I

F
— Transpose

Transpose

[0} Transpose by:
e 0 semitones

C Transpose...
from: ® 3
to: Ea C#3

Apply )

MIDI Operations window, Transpose option

34 Pro Tools Menus Guide

Grid/Groove Quantize

This command lets you adjust the placement of
selected MIDI events in a track using Grid or
Groove Quantize.

8 MIDI Operations

~| Grid/Groove Quantize Fﬂi
What to Quantize
E Attacks ! Releases
S Preserve note duration
Quantize Grid

& 1/16 note B

: Tuplet: 3 in time 2
| Offset grid by: 0 ticks
[ Randomize: er - 0%
Options
! Swing: C‘ - 100 %
) Include within: © 100%
[ Exclude within: - ~ 0%
] Strength: : © 100%

MIDI Operations window, Grid/Groove Quantize page

Grid Quantize lets you adjust the placement of
selected MIDI events in a track so that their start
or end points precisely align to the quantization
value chosen.

Groove Quantize lets you adjust the placement
of selected MIDI events in a track so that their
timings, durations, and velocities align to the
selected groove template grid. Pro Tools installs
several pre-defined groove templates for use on
all Pro Tools systems. With Pro Tools HD, Digi-
Groove templates can be created using Beat De-
tective.



Restore Performance

This command lets you restore the original
MIDI performance regardless of how many edits
you’ve made or whether or not the undo queue
has been cleared (for example, by saving the ses-
sion). One or more of the following note at-
tributes can be restored: Timing (Quantization),
Duration, Velocity, and Pitch.

[&] MIDI Operations

F
— Restore Performance

I

Select the note attributes to restore:

E! Timing {Quantization)
E Duration

1 velocity

 pitch

€ Apply )

MIDI Operations window, Restore Performance page
Flatten Performance

This command lets you lock the specified cur-
rent note parameters as the “restore to” state,
overriding the original performance. One or
more of the following note attributes can be flat-
tened: Timing (Quantization), Duration, Veloc-
ity, and Pitch. Flatten Performance can be un-
done.

[&] MIDI Operations

" Flatten Performance

5

Select the note attributes to flatten:

E Timing {Quantization)
E Duration
: Velocity

1 pitch

Capply )

MIDI Operations window, Flatten Performance page

Change Velocity

This command lets you adjust attack and release
velocities for selected MIDI notes. Use it to make
notes louder or softer, or to create a crescendo or
diminuendo.

6] MIDI Operations

= Change Velocity

I

Change velocity of

FE Attacks | Releases
—_ Options
® serall to: —— ]
O add: G 1ol
) subtract: " 1fromall
(O scale by: " Z00l%
O Change smoothly: from:| 1
to:| 127

C Change smoothly by percentage:

fram: 1%
/ to:| 400%
——
Curve: v 1]
— Limit to: min of 1 and
max of 127

[ Randomize: e 0%

€ Apply )

MIDI Operations window, Change Velocity page
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Change Duration

This command lets you adjust the duration for
selected MIDI notes. It can be used to make mel-
odies and phrases more staccato or more legato.

6] MIDI Operations

—_ Change duration

_[ Change Duration Fﬂi

® set all to: 17 ooo
O Add: 1 000/ to all
) subtract: 1| 000 from all

O scale by: 2 00%
) Move releases to the closest attack

0

R

Extend releases to the next attack

] Add no more than: S
| Add no more than: 1 oool
O Change smoothly from:| 0/ 001
to:| 1| oo0

0O Change smoothly by percentage:

from: 50 %

/ to; 200/%
Curve: %)

] Limit range: min of 0 ool
and max of 2595 953

"1 Randomize: e 50 %

 Aoply )

MIDI Operations window, Change Duration page
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Transpose

This command transposes selected MIDI notes
up or down the musical scale by a specific num-
ber of semitones (half steps). With this feature,
you can easily add key changes and other trans-
position effects to MIDI tracks.

6] MIDI Operations

[
_ Transpose I-Hi
L

Transpose

® Transpose by:
T semitones
O Transpose...
from: ™| (3
o T T

€ Appiy )

MIDI Operations window, Transpose page



Select/Split Notes

The Select/Split Notes command provides tools
to do the following:

e Select MIDI notes based on pitch, velocity, du-
ration, and position. These controls can be
used to select a single note or note range for
the entire length of a region or track.

e Split selected note and controller to the clip-
board, to new tracks, or multiple new tracks
based on pitch (one new track is created for
each different pitch in the selection).

The Select/Split Notes window can be used to
quickly extract a melody line from a keyboard
performance. Or, select a drum kit or similar
multi-voice performance track and automati-
cally create multiple new tracks, one for each
pitch in the selection.

(@] MIDI Operations

CRE

—_r Select/Split Notes
Pitch Criteria:
) All notes

@ Notes Between

CZ2 and c3
O Top 1 notes of each chord

) Bottom 1 notes of each chord

Other Criteria:

| welacity between liand 127

| Duration btwn 0 000 and 1 000
] Position btwn 1 000 and 1 000
Action:

@® Select notes
) split nates

Cut + | notes to | the clipboard

_ Include MIDI Controller Data
(Requires time selection)

€ Avply )

MIDI Operations window, Select/Split Notes page

Input Quantize

This command lets you quantize MIDI notes as
they are performed and recorded. While this
will improve the strict rhythmic accuracy of a
performance, it can also give it a stiff, mechani-
cal feel. To preserve the original rhythmic nu-
ances of a performance, experiment with lower
Strength settings, or deselect the Enable input
quantize option.

6] MIDI Operations

= Input Quantize

I

] Enable input guantize

__ What to Quantize
™ Artack | Release

E Preserve note duration

__ Quantize arid

JJIB N

= Tuplet: 3 intime 2
! offset grid by: O ticks
) Swing: O 100)%
—_ Options
1 Include within: ) 100%
1 Exclude within: E—— 0%
[ strength: S 100/%
: Randomize: e 0%

MIDI Operations window, Input Quantize page
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Step Input

This command lets you use a MIDI controller to
enter notes individually, one step at a time. This
gives you precise control over note placement,
duration, and velocity. With MIDI step input

you can also create musical passages that might
be difficult to play accurately, or at a fast tempo.

[&]

! Step Input [
E Enable
Destination "MmiDI 4 )

Step Increment

TR

[ Tuplet: 3| in time 2

Note length: *© e " 100%

Options

e Use input velocity
() set velocity ta: o) 64

g Enable Numeric Keypad Shortcuts

{ Undo Step N f Next Step ]

none note: Cé

{ Redo Step )

—

<none>

MIDI Operations window, Step Input page
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MIDI Event List

This command opens the MIDI Event List win-
dow. This floating window shows the contents
of a MIDI track in a single list., so you can
quickly insert, edit, or locate any type of MIDI
data using your computer keyboard.

[SXsXs) MIDI Event List
[ 12 Trilogy Bass IWI'Upuons [| Inser

111000 |

& | volume
F-1 94 &4 | 02000 m

L1 104 &4 | ol 1000

54015
b &)1/ 000
6] 2| oo |
62/ 420
613 420
€] 4| 000 £z 31 e4 | 0lojse2

[
4
4
d b1 82 e4 | olo4s0
4
d
4
sl4l4z0/ J D2 91 e4 | oioi4s0
4
4
d
4
4
4
J

Eb2 96 54 | 0l1]000
D2 95 &4 | 00|54

7i1loool Jd o1 108 64 | ol oo0
7lzio00 J b1 108 &4 | olol4so
712420 J 6™ 2 &4 | 0i1)000
61 31 e4 | olgl4s0
F1_ % &4 | olol4s0
G100 &4 | 00480

73480
7l 4 000 |
7| 4l 480
miionnl 1 m ine se | niioon

[ = )« 4

MIDI Event List

MIDI Track Offsets

This command opens the MIDI Track Offsets
window. This window lets you create timing off-
sets for MIDI tracks to compensate for MIDI-to-
audio latencies in hardware-based or software-
based MIDI synthesizers.

006 MIDI Track Offsets

Glabal MIDI Playback Offzet (-10,000 to

Trilagy Bazs o 5.8
Blad Pad Midi o i G100
Redrum o [}

MIDI Track Offsets window



By configuring a MIDI offset, you can make
MIDI tracks play back slightly earlier (by a spe-
cific number of samples), thereby compensating
for any audio monitoring latencies. MIDI offsets
affect playback only and do not alter how MIDI
data is displayed in the Edit window.

MIDI Real-Time Properties

This command opens the Real-Time Properties
window. This window lets you adjust and apply
MIDI quantization, duration, delay, velocity,

and transposition parameters during playback.

a Real-Time Properties

Apply to :| reqion "marinba-05" ¢|

| Clear Region Properties " Write to Region I

> [52] IE  sving
| Duraticn | > |+ :I - |ticks¢|
(oo | [+ ) o foss]

[ron e o= ES
(o2 K- K

MIDI Real-Time Properties window

Remove Duplicate Notes

The Remove Duplicate Notes command lets you
quickly identify and remove MIDI notes that
were unintentional “double-hits.”

If a note starts within the first 25% of the dura-
tion of a note of the same pitch which is already
sounding (or within an eighth-note, whichever
is shorter), it is considered a duplicate and is
combined with the previous note. If a note starts
later than 25% of the duration, it is considered
to be a new, distinct note, and is shortened so
that it ends at the same tick at which the next
note starts.

Beat Detective

This command opens the Beat Detective win-
dow. Beat Detective automatically detects the
tempo of a session and conforms an audio track
or selection to that tempo by separating it into
regions and aligning it to the beats. Beat Detec-
tive is ideal for tailoring a performance to a
groove. For detailed information about Beat De-
tective, refer to the Pro Tools Reference Guide.

Beat Detective window

Identify Beat

This command lets you establish a tempo/meter
map for audio that was recorded without listen-
ing to a click, or for imported audio with un-
known tempos.

Add Bar | Beat Marker

Location: || 1| oo
Time signature: 4

4

(Canesl ) &

e 3
Identify Beat dialog

The Identify Beat command analyzes a selection
range (usually with a distinct number of beats or
measures) and calculates its tempo based on the
specified meter. In doing this, Bar|Beat markers
for the calculated tempo are inserted and appear
in the Tempo Ruler at the beginning and end of
the selection. in addition, meter events are in-
serted into the Meter Ruler.
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Renumber Bars

This command lets you renumber the bars in
the session, effectively changing the bar loca-
tions for all regions, meter and tempo events
while leaving their position intact. In doing so,
however, the SMPTE and sample locations of
the session data are not changed.

Renumber Bars

Renumber bars so that...

bar 1 becomes bar 4

(" Cancel )  (Renumberd)

Renumber Bars dialog

All MIDI Notes Off

This command sends an All Notes Off MIDI
message to all MIDI devices connected to your
system to silence any stuck notes.
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chapter 8

AudioSuite Menu

AudioSuite Menu

The AudioSuite menu allows you to access all
AudioSuite plug-ins currently installed in your
system’s Plug-Ins folder. AudioSuite plug-ins are
non-real-time, file-based processing plug-ins for
Pro Tools.

AudioSu ite

1-Band EQ 3

1-Band EQ Il

4-Band EQ Il

7-Band EQ 3

BF Essential Clip Remover
bombfactory BF76
Chorus

Compressor

D-Verb

DC Offset Removal
DeEsser

Delay

Duplicate
Expander-Gate

Flanger

Funk Logic Mastererizer
Gain

Gate

Invert

Limiter

Multi-Tap Delay
Narmalize

Ping-Pong Delay

Pitch Shift

Reverse

Signal Generator

Time Compression Expansion

AudioSuite menu (plug-ins organized by Flat List)

AudioSuite
EQ
Cynarmics
Pitch Shift
Reverb
Delay
IMadulation
Ciher

LR R A

AudioSuite menu (organized by Category)

This chapter includes all the AudioSuite plug-in
categories and the DigiRack plug-ins that are in-
cluded in them.

For details on each of the AudioSuite plug-
ins, refer to the DigiRack Plug-Ins Guide.

EQ Plug-ins

1 Band, 2-4 Band, and 7 Band EQ IlI

The EQ III plug-ins adjust the frequency spec-
trum of an audio selection. These plug-ins are
flexible EQ types for maximum CPU and DSP ef-
ficiency.

On the 1 Band EQ, the EQ Type selector lets you
choose any one of six available filter types:
High-Pass, Notch, High-Shelf, Low-Shelf, Peak,
and Low-Pass.

On the 7 Band EQ and the 2-4 Band EQ, the
HPF, LPF, LF, and HF sections have EQ Type se-
lectors to toggle between the two available filter
types in each section.
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1-Band EQ Il and 4-Band EQ Il

The EQ II plug-ins adjust the frequency spec-
trum of an audio selection. The 1-band EQ can
be configured as a high-pass, low-shelf, high-
shelf, low-pass, or peak EQ. The 4-band EQ pro-
vides one high-shelf, one low-shelf, and two
peak EQs.

Dynamics Plug-Ins

Compressor Il

The Compressor II plug-in reduces the dynamic
range of signals that exceed a selected threshold
by a specific amount.

DeEsser

The DeEsser plug-in reduces sibilants (“s,” “sh,”
and “t” sounds) and other high frequency

noises that can occur in vocals, voice-overs, and
some wind instruments. These sounds can cause
peaks in an audio signal and lead to distortion.

The DeEsser reduces these unwanted sounds us-
ing fast-acting compression. A Threshold con-
trol sets the level above which compression
starts, and a Frequency control sets the fre-
quency band in which the DeEsser operates.

Expander-Gate Il

The Expander-Gate II plug-in is useful for reduc-
ing noise or signal leakage that creeps into re-
corded material as its level falls, as often occurs
in the case of headphone leakage.

42 Pro Tools Menus Guide

Gate Il

The Gate II plug-in is useful for noise removal
on individual tracks, and can be used for special
effects such as cutting off a reverb tail.

Limiter Il

The Limiter II plug-in is used to prevent signal
peaks from ever exceeding a chosen level so that
they do not overload amplifiers or recording de-
vices.

Pitch Shift Plug-Ins

Pitch Shift

The Pitch Shift plug-in changes the pitch of the
currently selected region, with or without
changing its duration. It also allows you to per-
form Time Compression/Expansion on your se-
lection simultaneously with a pitch change.

Reverb Plug-Ins

D-Verb

D-Verb is a studio-quality reverb. Reverberation
processing can simulate the complex natural re-
flections and echoes that occur after a sound has
been produced, imparting a sense of an acoustic
environment. D-Verb artificially creates a sound
space with a specific acoustic character.



Delay Plug-ins

Delay

The Delay plug-in provides time delay-based ef-
fects, with up to 10.9 seconds of delay (regard-
less of the sample rate). In addition to long de-
lays, you can create many delay-based effects
with this plug-in, including slap echo, doubling,
chorusing, and flanging.

Multi-Tap Delay

The Multi-Tap Delay plug-in adds up to four in-
dependently-controllable delays or taps to the
original audio signal. By allowing you to indi-
vidually control the delay time and number of
repetitions of each of the four taps, the Multi-
Tap delay provides greater flexibility than stan-
dard single-delay devices.

Ping-Pong Delay

The Ping-Pong Delay plug-in modifies an audio
signal by adding a controllable delay to the orig-
inal signal. It is ideal for adding spatialization,
and when used in stereo, adds panned echo to
virtually any instrument. In stereo mode, this
plug-in will feed back delayed signals to their
opposite channels, creating a characteristic
ping-pong echo effect.

Modulation Plug-Ins

Chorus

The Chorus plug-in modifies an audio signal by
combining a time-delayed, pitch-shifted copy
with the original signal. It is ideal for thickening
and adding a shimmering quality to guitars,
keyboards, and other instruments.

Flanger

The Flanger plug-in combines a time-delayed,
pitch shifted copy of an audio signal with itself.
The Flanger differs from other digital flangers in
that it uses a thru-zero flanging algorithm that
results in a truer tape-like flange. This technique
delays the original dry signal very slightly (ap-
proximately 256 samples), then modulates the
delayed signal back and forth in time in relation
to the dry signal, passing through its zero point
on the way.

Harmonic Plug-Ins

Harmonic plug-ins include plug-ins that change
the harmonic quality of audio (such as Aphex
Aural Exciter).

Noise Reduction Plug-Ins

Noise Reduction plug-ins (such as Sonic No-
NOISE) are used for removing pops, clicks, hum,
and other unwanted noise that occur in audio.

Instrument Plug-Ins

Instrument plug-ins include soft synths or re-
combinatorial thythm machines (such as Digi-
design’s Synchronic plug-in).
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Other Plug-Ins

The Other Plug-In category includes plug-ins
that do not fit into a standard category, or are
third party plug-ins that have not had a cate-
gory designated to them by their manufacturer.

DC Offset Removal

The DC Offset Removal plug-in recognizes and
removes spikes caused by DC offset in the cur-
rently selected region if any are present.

Duplicate

The Duplicate plug-in duplicates a selected area
or region in place. The Duplicate plug-in is use-
ful for creating a single audio file from a selec-
tion encompassing many smaller regions with
areas of silence between them.

Gain

The Gain plug-in adjusts the gain (volume) of
the currently selected region in decibels or a per-
centage value.

Invert

The Invert plug-in inverts the phase (polarity) of
the currently selected region.
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Normalize

The Normalize plug-in uniformly adjusts all lev-
els in the currently selected area to a user-defin-
able level, referencing the loudest peak in either
a specific region, or examining the relative peak
level of several regions.

Reverse

The Reverse plug-in rewrites the currently se-
lected region in reverse, producing a backwards
audio effect.

Signal Generator

The Signal Generator plug-in produces audio
test tones in a variety of frequencies, waveforms,
and amplitudes. It is useful for generating refer-
ence signals with which to calibrate various ele-
ments of your studio.

Time Compression/Expansion

The Time Compression/Expansion plug-in
changes the length (duration) of the currently
selected region, with or without changing its
pitch.
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Options Menu

Options Menu Destructive Record

In Destructive Record mode, recording over ex-
The Options menu commands lets you select

several editing, recording, monitoring, play-
back, and display options.

isting regions replaces the original audio perma-
nently. This allows you to conserve hard drive
space. However, if you have sufficient drive
space, it is usually best to disable Destructive

Setup Window Help [HH] «)
|

Destructive Record

Record mode, and use Pro Tools in Nondestruc-
tive Record mode to avoid losing any previously

Loop Record el
QuickPunch 3P recorded material.
TrackPunch {+38T

Transport Online )
0D T nline {+38)

Loop Record

Pre/Post-Roll 32K Loop Record lets you record take after take while

v Loop Playback oL the same section of audio repeats. This is a con-
Scrolling > venient technique for quickly recording multi-
v Link Timeline and Edit Selections 1t/ ple takes of a part without losing spontaneity.
Link Track and Edit Selections
Mirror MIDI Editing The time range that is looped and recorded—
¥ Automiar o Follows kdit which must be at least one second in length—is
Click defined by selecting a range in the Ruler or in a
e track’s playlist, or by specifying start and end
Mute Frees Assigned Voice points in the Transport window.
Auto-Spot Regions ®P
v Pre-Fader Metering
Solo Mode > Quickpunch
Calibration Mode X . i
v Delay Compensation QuickPunch lets you instantaneously punch-in

(initiate recording) on a record-enabled audio
track during playback, then punch-out (exit re-
cording) by clicking the Transport’s Record but-
ton. Recording with QuickPunch is nondestruc-
tive.

Options menu (Pro Tools HD)
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TrackPunch
(Pro Tools HD Only)

TrackPunch lets you punch individual tracks in,
punch individual tracks out, and take tracks out
of record enable without interrupting online re-
cording and playback. Recording with Track-
Punch is nondestructive.

Transport Online

This command arms the Pro Tools Transport for
online synchronization. Playback or recording
can then be triggered by an external time code
source. Online recording or playback begins as
soon as Pro Tools receives and locks to time
code or ADAT sync.

Video/Movie Track Online
(Pro Tools HD Only)

This command enables and disables playback of
a QuickTime movie or Avid Video. You may
want to do this to have the movie or video fro-
zen at a particular point in time relative to

Pro Tools playback, or to give highest screen up-
date priority to other Pro Tools tasks such as me-
tering, moving faders, and so on.

Movie Track Online
(Pro Tools LE and M-Powered Only)

This command enables and disables QuickTime
movie playback. You may want to do this to
have the movie frozen at a particular point in
time relative to Pro Tools playback, or to give
highest screen update priority to other Pro Tools
tasks such as metering, moving faders, and so
on.
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QuickTime DV Out FireWire
(Macintosh Only)

This command plays the current movie out the
FireWire port. You may want to do this to have
a Digital Video deck, monitor, or camcorder
record or display DV (digital video) playback
from Pro Tools.

For a list or supported DV FireWire
transcoders, visit the compatibility pages on
the Digidesign Web site
(www.digidesign.com).

Pre/Post-Roll

This option enables pre- and post-roll playback.
Pre- and post-roll amounts can be entered in the
Transport window, set from a track’s playlist or
Timebase Ruler, or by recalling a Memory Loca-
tion.

Loop Playback

This option continuously loops playback of a se-
lection until you stop playback. Looping play-
back is a useful way to check the rhythmic con-
tinuity of a selection when working with
musical material. Selections must be at least 0.5
seconds in length to use Loop Playback.



Scrolling

Pro Tools provides several options for defining
how the contents of the Edit window scroll dur-
ing playback and recording. These include:

None

The None option disables scrolling during and
after playback. With this option enabled, the
playback cursor moves across the Edit window,
indicating the playback location, up to the right
edge of the Edit window. When the play point
moves beyond the right edge of the Edit win-
dow, the Playback Cursor Locator icons appear
at the right edge of the Main Timebase Ruler.

After Playback

The Scrolling After Playback option causes the
Edit window to scroll to the final playback loca-
tion after playback has stopped. With this op-
tion enabled, the playback cursor moves across
the Edit window, indicating the playback loca-
tion.

Page

The Page Scrolling option causes the Edit win-
dow to scroll during playback. With this option
enabled, the playback cursor moves across the
Edit window, indicating the playback location.
When the right edge of the Edit window is
reached, its entire contents are scrolled, and the
playback cursor continues moving from the left
edge of the window.

Continuous
(Pro Tools HD Only)

The Continuous Scrolling option causes the Edit
window’s contents to scroll continuously past
the playback cursor, which remains in the cen-
ter of the window. With this option enabled,
playback is always based on the Timeline selec-
tion (Playhead).

Center Playhead
(Pro Tools HD Only)

This option causes the Edit window’s contents
to scroll continuously past the Playhead, which
is a blue line in the center of the window (red
when recording).

A\ Regardless of which Scrolling option is se-
lected in the Options menu, Pro Tools does
not scroll when zoomed down to the sample
level.

Link Timeline and Edit Selection

This option lets you link or unlink any Timeline
selection with any Edit selection.

When Link Timeline and Edit Selection is en-
abled, making a selection in a track’s playlist (an
Edit selection) also defines the play and record
range (the Timeline selection).

When Link Timeline and Edit Selection is dis-
abled, you can make a selection within a track
for editing purposes that is distinct from the se-
lection in the Timeline (which determines the
playback and recording range).
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Link Track and Edit Selection

This option lets you link or unlink any track se-
lection with any Edit selection.

When Link Track and Edit Selection is enabled,
you can make an Edit selection within a track or
across multiple tracks and each associated track
is selected.

When Link Track and Timeline Selection is dis-
abled, making an Edit selection does not auto-
matically select all associated tracks.

Mirror MIDI Editing

This option lets you edit MIDI regions and have
your edits automatically applied to every MIDI
region of the same name. This can be particu-

larly useful when editing looped MIDI regions.

Automation Follows Edit

When this option is disabled, automation
events are not affected by edits to audio or MIDI
notes. When enabled, automation events are af-
fected by edits to audio or MIDI notes.

Click

When the Click command is enabled, a metro-
nome event is generated during playback and
recording. The metronome can trigger an exter-
nal MIDI device (as specified by the Output set-
ting in the Click Options dialog) or the DigiRack
Click TDM or RTAS plug-in (see the DigiRack
Plug-Ins Guide).
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MIDI Thru

Enabling the MIDI Thru command routes MIDI
from your controllers to the devices and chan-
nels assigned to the MIDI track currently record-
enabled. This allows you to monitor MIDI tracks
while recording.

Mute Frees Assigned Voice
(Pro Tools HD Only)

When this option is enabled, a muted track’s
voice will be allocated to the next highest prior-
ity track assigned to the same explicit voice.

Auto-Spot Regions

(Pro Tools HD and Pro Tools LE with DV Toolkit
Only)

When enabled, this option simplifies the task of
spotting regions. If you are using VITC with this
option enabled, or MachineControl software,
you can pause your video at an appropriate
SMPTE frame location, click on a region with
the Grabber, and the region will be automati-
cally spotted to the current time code location.

Pre-Fader Metering

This option toggles track metering between pre-
and post-fader operation. When set to Pre-Fader
Metering, level meters show levels independent
of fader position. With post-fader metering, the
level meters respond to fader position. This op-
tion only affects on-screen meters.



Solo Mode
(Pro Tools HD Only)

Pro Tools provides several modes for defining
how track Solo buttons work.

SIP (Solo In Place)

When this mode is enabled, the Solo button
mutes other tracks so that the chosen track can
be auditioned alone.

AFL (After Fader Listen)

When this mode is enabled, the Solo button
routes the track’s post-fader/post-pan signal to
the AFL/PFL Path output, which is set in I/O
Setup.

A\ AFL Solo mode requires the Surround Mixer
plug-in (see the Pro Tools Reference Guide
for installation information).

PFL (Pre Fader Listen)

When this mode is enabled, the Solo button
routes the track’s pre-fader/pre-pan signal to the
AFL/PFL Path output, which is set in I/O Setup.

A\ AFL Solo mode requires the Surround Mixer
plug-in (see the Pro Tools Reference Guide
for installation information).

Calibration Mode
(Pro Tools HD Only)

Use Calibration Mode in Pro Tools to adjust the
input and output levels for your audio interface
(such as the 192 I/O or the 888|24 I/0O) so they
match those of your mixing console and other
audio devices in your studio.

Delay Compensation
(Pro Tools HD Only)

When this option is enabled, Pro Tools captures
reported plug-in delays and signal routing for all
tracks and calculates the correct delay for each
track, compensating all the tracks accordingly.

Low Latency Monitoring
(Digi 002 and Digi 002 Rack Only)

Digi 002 and Digi 002 Rack systems can use the
Low Latency Monitoring option to record with
an extremely small amount of monitoring la-
tency, to as many tracks as each system sup-
ports.
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chapter 10

Setup Menu

Setup Menu Hardware

The Hardware Setup dialog lets you specify set-
This menu lets you opens dialogs and windows tings for your hardware and sessions. Configure
or choose commands for configuring various the settings for any audio interface connected to
Pro Tools hardware and software parameters. your Pro Tools system by selecting it from the

Peripherals list.

Hardware. .. ' The Main page of the Hardware Setup dialog can
Plavback Engine... be used to define what physical ports are routed
to Pro Tools input and output channels. The
Main page also provides controls for Session

Disk Allocation...

Peripherals... Sample Rate, Clock settings, and defining
Lo... whether Expansion Port or Legacy Port periph-
QuickTime Mavie Offset.., erals are active (Pro Tools HD only).
Session Cir+2]
| Forigherals Interlacs: 96 LD
ST i ] ABEG A
gt Finitsd Erumat
MICT v ]
Erva— f::ﬂ—‘"ﬂﬂf—]: : EErTEre—
Click... Clnck Sowce s [o,:zllr c
Prafe -"L;';‘w —— =l :;:j Ovptal Enc] (AESIEBL), SFDIF)
rererences, ., ;u::u Rote o 1696 [CpiealTE T
Mters; [Tupt | Ex
Setup menu TTE——
Cliawsty oo ] (e’

Hardware Setup dialog, Main page

With Pro Tools|HD, additional pages can be
used to configure other parameters on each au-
dio interface (such as setting operating levels).
Refer to the Getting Started Guide for your

Pro Tools system.
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Playback Engine

This Playback Engine lets you set a hardware
buffer size, define the RTAS Processors alloca-
tion on multi-processor computers, and allocate
a percentage of CPU resources for these tasks.

On Pro Tools|HD systems, you can select the
number of voices and voiceable tracks for your
system and its sessions. Voice count choices are
based on how much DSP processing you want to
allocate for voicing. If you change the Number
Of Voices setting (Pro Tools HD only) mid-ses-
sion, the session will be saved, closed, and re-
opened to enable the new settings.

10 T Settsngs
L o

ATAS Processors: [1 Froseseee 9

e ——

N 4 ks [31 Voieme 1657 =

Sanphe Bate: [H4.1 Itz 4
|

e

DAL Playbock faller

son [imed 2 oty

e 3P of st rrr. Yo ey b 11598 acatecd
[ iirirsze st merwory slocacion (iskes sifect o nast restmth

Playback Engine dialog

Disk Allocation

If you are using multiple hard drives for record-
ing, use the Disk Allocation dialog to assign
each track in a session to a specific drive. Audio
for that track will then be recorded to the cho-
sen drive.

[ [ SSEET —

Clcusten sleeaten Crteen
Rt rects hbder|

e v 0o shacatn o e ke

Disk Allocation dialog
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Peripherals

This Peripherals dialog provides several tabbed
pages (Synchronization, Machine Control,
MIDI Controller, Ethernet Controller, and Mi-
crophone Preamp) for configuring various pe-
ripheral device for use with Pro Tools (such as
Digidesign’s SYNC I/O, ProControl, or PRE).

Synchronization

This page configures synchronization devices
such as Digidesign’s SYNC I/O to synchronize
Pro Tools to SMPTE Time Code. It also provides
MIDI Machine Control (MMC) configuration
for slaving Pro Tools to MMC.

[ — )
Synchvoniaton | Machne Contral | MIDI Controbers | Etherned Controliers | Mic Preses
Davice Part
= s ) -
Mnmum SycDeloys | 40 [Frames

[lErsite Goniral G Fra Topk oe MV o
SPNC Satup
[ Erabie SYMC Setup
Cument Fmmare Verson e
Wertcal Posttor:
Hortmntsl Fosttory
L Update SYNC Fmyan J Calors

o ]

Peripherals dialog, Synchronization page



Machine Control

This page configures MIDI Machine Control and
9-pin machine control devices for use with

Pro Tools. MIDI Machine Control is supported
on all Pro Tools systems. 9-pin Serial and Re-
mote 9-Pin Deck Emulation modes require
Digidesign MachineControl™.

Peripherals L]
Syrctwuriasaon | Madne Contrel | vaot Controlers | Efemet Controbers | Mcreamss

ML Macune: Conral

e ST 10 sy Ve Clock Rusfiarence)
3 Remote
ot Hachine Type
[l Eratie

Peripherals dialog, Machine Control page
MIDI Controllers

This page configures MIDI control surfaces such
as the Command|8.

Pesipherals

Syncheonuzabon | Macne Control | MIDN Contraters | Eiremet Conrolers
Tupe Hmcerve Fram terd To oo
21 [l [Coomence -] [CEMan -] [CEmaoutr_-] [2 -
=2 [ [none =
=3 [l (rece -
#4 [ [roce =,
=

Peripherals dialog, MIDI Controllers page

Ethernet Controllers

This page configures D-Control, D-Command,
ProControl, Fader Packs, Edit Pack, or Con-
trol|24 for use with Pro Tools.

Perigherals =

Sm.m Mactine Coriral | MIDE Confrollers | Eemnet Controlers | i Presmps
Etherrat Port
Eltratie (i) PR0/07]
[tame uni(z] ]
. s

Peripherals dialog, Ethernet page

Mic Preamps
(Pro Tools HD Only)

This page configures one or more Digidesign
PREs for use with Pro Tools.

Peripherals [£3

Sychroranation | Madhne Control | MIDE Controlers. | Efwernet Controlers | M Preamps

Tape Riecate Fram SendTe Dedauis  Retan Curveni Setiings

o E) e ) o

] none -

il

[Remate Lock-Cuit Mode

[ oneel ] [ ]

Peripherals dialog, Mic Preamps page
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1/0

This I/O Setup dialog provides tools to label and
map Pro Tools input, output, insert, bus signal,

and Mic Preamp (PRE) paths. The I/O Setup dia-
log also lets you configure delay compensation

for hardware inserts.

Inpet | Gueut | insert | Bus | Wi Preamps | HAW ins et Distay |

e Ln ows
W =
[Fudition 5] NewFah [ Deran
D Cutpt -
[Cufauk Fa Crzar -] [ _impontSetings | [ Emonsetings | [ cancsl | o

/0 Setup dialog, Output page

In addition, the I/O Setup dialog, like the Main
page of Hardware Setup, provides controls for
routing the physical ports on your audio inter-
face (such as a 96 1/0) to Pro Tools Input and
Output channels. The Output page of the

I/O Setup dialog also lets you change the default
path settings for Meter, Audition, and multi-
channel track layout (as displayed on-screen).
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Machine Track Arming Profiles

(Pro Tools HD with MachineControl Option
Only)

This dialog provides extensive control over
Pro Tools Track Arming. You can customize
arming, track naming and mapping, and save
configurations for different machines as Track
Arming Profile files. These Profiles can be im-
ported to quickly reconfigure Track Arming as
needed for future projects. You can also test
track mapping, and remap tracks if needed.

QuickTime Movie Offset

When you import a QuickTime movie into a ses-
sion, by default, the first frame of the movie is
set to the start time of the session. In some cases,
you may need to offset the movie earlier or later
so you can accurately spot audio to it. The Set
Movie Sync Offset command allows you to set
this offset in 1/4-frame increments. This is more
accurate than dragging the movie track, and is
especially useful in cases where a movie track
begins with a partial frame.



Session

This Session Setup window lets you configure
various session parameters including session
start frame, SMPTE frame rate, offset settings,
SYNC I/O settings (clock and pull-up/pull-
down), and several time code parameters.

Sampie Raate: 48 b Sucho Format: BWF { WAV} Sesson et D0:SELARO0
Bt Depthe 164t Incomng Tme:  00:00:00:00
] EEr—

Fiet <Frumen e

Clock Source: | SC LD
Syvoem el —

[E2) SNC Setup & Time Code Dffsets
SNC Seap

Exterray Tina Cote Offaess
ok Ratererce: <
S ——
Video Format: | NTSC o
[Jwsa
loce: @ Seeed i O
(=] Time Code Settings
Genaran Fresihes #ul LD

g s O st Rt Pl LD

1 L
W To Por= | 8 Mamas Vides et Pl Ui BBiorm:
fr— O som s [ —
Time Code Rasder Offpet: ) segles

Session Setup window

Current Feet+Frames Position

(Pro Tools HD and Pro Tools LE with DV Toolkit
Only)

Redefine Current Feet+Frames Position [‘5__<|

Current Time Code Position: 01:00:00:06

Desired Feet+Frames Position: 1 @E

[ Cancel ] [ OK ]

Current Feet+Frames dialog

This command lets you specify a Feet+Frames
value based on the current Edit cursor time code
location. Typically, this feature lets test tones,
pre-roll, Academy leader, and similar pre-pro-
gram material to be more easily integrated into
Pro Tools sessions.

Current Time Code Position
(MachineControl Option Only)

This command lets you redefine the session
start time. By creating an insertion point (or se-
lection) and then entering the desired new time
code position for that location, the session start
time will be recalculated based on the new, rela-
tive Time Code location.

oo Redefine Current Timecode Position rg|

Current Timecode Position: 17:58:38:29

Desired Timecode Position: ]_... 17

[ Cancel ] [ QK

Current Time Code Position dialog

External Time Code Offset

This command lets you compensate for devices
that are consistently offset by a fixed number of
frames (such as some color—corrected video mas-
ters), or for material that starts at a different
time than the session.

Pro Tools provides three different types of Exter-
nal Time Code Offset settings. These offsets in-
clude:

e MMC (MIDI Machine Control)
e 9-Pin (Serial machine control)
e Synchronization peripherals (such as the

SYNC I/O, or a MIDI interface that provide
MIDI Time Code).

Positive and negative offset values can be en-
tered to offset Pro Tools time code display later
or earlier, respectively.

Unique values can be defined for each of these
three types offsets, or you can link all three to
adjust in unison.
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MIDI Studio

The MIDI Studio command opens the MIDI Stu-
dio Setup window (Windows) or launches the
Apple Audio MIDI Setup application (Macin-
tosh). These let you identify the MIDI devices
connected to your MIDI interface.

MIDI Beat Clock

This command lets you enable synchronization
for certain MIDI devices (such as drum ma-
chines, software synthesizers, and hardware se-
quencers) to MIDI Beat Clock. Devices selected
in the MIDI Beat Clock dialog will receive the
MIDI Beat Clock signal. If your MIDI interface
does not support transmitting MIDI Beat Clock
to separate ports, the interface will appear as the
only destination.

MIDI Beat Clock. 5]

Enable MIDI Beat Clock for...

[CIMicrosoft MIDI Mapper [Emulated]

Plug-ins that self-configure to receive MIDI Beat Clock will not
be fisted in this dislog.

MIDI Beat Clock dialog
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Input Filter

This command provides settings for filtering out
selected MIDI messages from your recording.
The Input Filter can be set to record all mes-
sages, only the specified messages, or all except
the specified messages. When using the Only
option, only the MIDI messages that are selected
will be recorded. Conversely, when using the All
Except option, the selected messages will not be
recorded.

MIDI Input Filter (3]
Record

Ol

O only...

(=) Al Except...

Channel Info Controllers

Do 0

Dlaeheand 0

Mona Aftertouch |l

Polyphonic Aftertouch |l

[l Program Changes [E]
O
0
0

[ system Exdusive

MIDI Input Filter dialog



Input Devices

This command enables selected MIDI control-
lers and control surfaces so that MIDI data re-
ceived from them can be recorded. Disabling de-
vices in this dialog will ensure that unwanted
notes (such as those from drum machines or an
arpeggiator) are not recorded.

MIDI Input Enable X

igidesign MIDI IO 1
igidesign MIDI IO 2
igidesign MIDI IO 3
igidesign MIDI IO 4
igidesign MIDI IO 5
Digidesign MIDI 10 6
Digidesign MIDI 10 7

i
Digidesign MIDI 10 10

[ Cancel ] [ oK ]

MIDI Input Enable dialog

Click

This command lets you configure metronome
parameters such as MIDI note, velocity, dura-
tion, and output. If you are using the Click plug-
in, set the output to None.

ountoff Options

Click
(®) During play and record
() Only during record
() Only during countoff
Mote Velocty Duration
Accented faic} 127 100 | ms
Unaccented 3 100 100 | ms
Qutput [none ']
Countoff
Only during record Bars
Click dialog
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Preferences

The Preferences dialog has several tabbed pages
in which you can specify your preferred settings
for various session parameters. Each new session
will use these preferences.

Display Preferences

Dala} | Cpmeuin | B | Auioradon | Procamng | MITE | Macrs Corirnl

Bt o Catmtt Lt =000

Crgraim Pugi= Mersa Ty [Caingay

T

Display Preferences page
Basics Section

Edit Window Follows Bank Selection Causes

Pro Tools to scroll the Edit window to display
the selected bank of tracks when you switch
banks on the MIDI controller, ensuring that the
current selection of tracks in the current bank is
viewable on-screen. This option is only available
if you are using D-Control, ProControl, Con-
trol|24, or a MIDI control surface that supports
Bank chasing.

Mix Window Follows Bank Selection Causes

Pro Tools to scroll the Mix window to display
the selected bank of tracks when you switch
banks on a supported MIDI or Ethernet control-
ler, ensuring that the current bank is viewable
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on-screen. This option is only available if you
are using D-Control, ProControl, Control|24, or
a MIDI control surface that supports Bank chas-
ing.

“Scroll To Track” Banks Controllers Causes sup-
ported control surfaces to bank faders to a track
position number selected through the Scroll To
Track command.

Track Position Numbers Stay with Hidden

Tracks When enabled, tracks keep their track
numbers even when hidden. When not en-
abled, numbers are only assigned to tracks that
are shown. In this case, active tracks are then
numbered sequentially, and hidden tracks are
un-numbered.

Show Meters in Sends View When the Sends
View is displaying individual send controls, you
can select this option to show send level meters.
Deselecting this option can help speed up
screen redraws and processing.

Draw Grids in Edit Window Adds grid lines to the
Edit window. Grid line resolution is based on
the zoom level of the Edit window.

Draw Waveforms Rectified Displays audio wave-
form data in rectified view. In this view, audio
waveforms are displayed so that their positive
and negative waveform excursions (the portions
that fall above and below the center line) are
summed together and viewed as a single posi-
tive-value signal. This view allows more wave-
form detail to be seen in either normal or re-
duced track height views. It can be particularly
useful when editing volume automation data,
since it depicts waveform levels as starting at the
bottom of the track.

Recompute Invalid Overviews Prompts Pro Tools
to look for missing or corrupted overview data
(the data used to create waveform displays)
when it opens sessions. If Pro Tools finds that
overview data is missing or corrupted, it will re-



create one or more overviews for the session.
This may take some time if there are many
tracks in the session. If you suspect that over-
view data for a session has become corrupted, or
if you import audio files which have no over-
view data into a session, make sure this prefer-
ence is enabled for the session, save and close
the session, then reopen it. Pro Tools will recre-
ate any overviews for the session when it opens.

Always Display Marker Colors Lets you choose to
view Marker colors in the Markers ruler, regard-
less of the settings you choose for Default Re-
gion Color Coding.

Tool Tips Display

Function Configures Tool Tip to show the basic
function of the item.

Details Configures Tool Tip to show the com-
plete name of an abbreviated name or item. De-
tails view can also show the hidden or abbrevi-
ated value of parameters, as well as input and
output assignments.

Other Options Section

Edit Window Default Length Lets you set a de-
fault length for the Edit window in hours, min-
utes, seconds, and frames (the frames value is
available with Pro Tools HD and Pro Tools LE
with DV Toolkit only). This capability is useful if
you wish to assemble a session of a particular
length or leave extra room to expand the Edit
window’s work area in your session. The maxi-
mum length is 13 hours at 48 kHz, and propor-
tionally less at higher sampling rates.

Delay Compensation Mode (Pro Tools HD Only)

This option lets you choose whether informa-
tion in the Delay Manager is displayed in milli-
seconds or samples. This option is only available
when Delay Compensation is enabled (Options
> Delay Compensation).

“Organize Plug-In Menus By” Option

This preference customizes how plug-in lists
(plug-in menus) are organized in the Insert Se-
lector or Plug-In Selector.

Flat List Organizes plug-ins in a single list, in al-
phabetical order.

Category Organizes plug-ins by process category
(such as EQ, Dynamics, and Delay), with indi-
vidual plug-ins listed in the category submenus.
Plug-Ins that do not have a Category defined
will appear in the “Other” Category folder.

Manufacturer Organizes plug-ins by their manu-
facturer (such as Digidesign, Eventide, Line 6,
McDSP), with individual plug-ins listed in the
manufacturer submenus. Plug-Ins that do not
have a Manufacturer defined will appear in the
“Other” manufacturer folder.

Most Digidesign-distributed third party plug-ins
will be sorted as Digidesign when view by man-
ufacturer is enabled.

Category and Manufacturer Organizes plug-ins
in two levels of menus. The top menus display
plug-ins by process category (such as EQ, Dy-
namics, and Delay), with individual plug-ins
listed in the category submenus. The bottom
menus display plug-ins by their manufacturer
(such as Digidesign, Eventide, Line 6, McDSP),
with individual plug-ins listed in the manufac-
turer submenus.

Default Track Color Coding

These color coding options determine the de-
fault color coding assignment for tracks in the
Edit and Mix windows. Choices are:

None Turns off default color assignment for
tracks.
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Tracks and MIDI Channels Assigns a color to
each track in the Edit or Mix window according
to its voice assignment or MIDI channel assign-
ment.

Tracks and MIDI Devices Assigns a color to each
track in the Edit or Mix window according to its
voice assignment or MIDI device assignment.

Groups Assigns a color to each track according to
its group ID. If groups are suspended using the
Suspend Groups command, the tracks color bars
are not shown.

Track Type Assigns a color to each track accord-
ing to its type (audio, Auxiliary Input, MIDI, In-
strument, or Master Fader).

Default Region Color Coding

These color coding options determine the de-
fault color coding assignment for regions in the
track playlist. Choices are:

None Turns off default color assignment for re-
gions. Regions are drawn with black waveform
or MIDI notes on a light gray background.

Tracks and MIDI Channels Assigns a color to
each region in the Edit window according to its
voice or MIDI channel assignment.

Tracks and MIDI Devices Assigns a color to each
region in the Edit window according to its voice
assignment or MIDI device assignment.

Groups Assigns a color to each region according
to the group ID of its track. If groups are sus-
pended using the Suspend Groups command,
all regions display black waveforms or MIDI
notes on a light gray background.

Track Color Assigns a region color based on the
color assigned to the track.

Marker Locations Assigns a color to data across
all tracks based on the nearest preceding marker.

60 Pro Tools Menus Guide

Region List Color Assigns a color to each region
based on its color in the Region List.

Peak Hold Options

These options determine how long the peak in-
dicators on track meters stay lit after a peak is
detected. Choices are:

3-Second When selected, track meters display
the last peak level for three seconds.

Infinite When selected, track meters display the
last peak level until you click them to clear
them.

None When selected, track meters do not hold
the peak level.

Clip Indication Options

These options determine how long clip indica-
tors on the track meters, plug-in header LEDs,
track names in the Show/Hide window and In-
sert and send buttons stay lit after a clip is de-
tected. Choices are:

3-Second When selected, clipping indication
displays for three seconds.

Infinite When selected, clipping indication dis-
plays until you clear the clip.

None When selected, clipping is not shown.



Operation Preferences

T P — e ]

Operation Preferences page

Timeline Insertion Follows Playback When se-
lected, causes the screen’s play cursor to update
its location to the point where playback stops.

Edit Insertion Follows Scrub/Shuttle When se-
lected, the edit cursor automatically locates to
the point where scrubbing stops.

Sends Default to —-INF When selected, sets the
initial fader level of newly-created Sends to —c
(no audible signal level).

Audio During Fast Forward/Rewind When se-
lected, audio is audible during fast forward or re-
wind.

Convert Imported “WAV” Files To AES31/Broad-
castWave When selected, this option applies to

all newly imported WAV files, making them
compliant with the AES31/EBU Broadcast stan-
dard.

Automatically Copy Files on Import When se-
lected, Pro Tools copies all imported audio files
to the current session’s Audio Files folder, re-
gardless of whether they need to be converted to
the current session’s file type, bit depth or sam-
ple rate.

Audio Track RecordLock When selected, audio
tracks remain record enabled when playback or
recording stops.

When deselected, record enabled audio tracks
are taken out of record enable when Pro Tools is
stopped.

Transport RecordLock When de-selected, the
Transport Record disarms when Pro Tools is
stopped due to playback or recording being
stopped, or due to loss of time code. This repli-
cates standard Pro Tools recording behavior.

When this setting is selected, the Transport
Record remains armed when playback or record-
ing stops, emulating digital dubber behavior.

Latch Record Enable Buttons When deselected,
prevents multiple tracks from being record-en-
abled. Record-enabling a track takes any other
track out of record-enabled mode.

Link Mix and Edit Group Enables When selected,
links enabling and disabling of Mix and Edit
groups: Enabling Group A in the Edit Window
automatically enables Group A in the Mix win-
dow.

Link Record and Play Faders When selected,

Pro Tools does not keep track of separate record
and play levels for audio tracks: Record enabling
a track has no effect on the fader level.

Use F11 Key for Wait for Note When selected,
pressing the F11 Function key puts MIDI record-
ing in Wait for Note mode.

Disable “Input” When Disarming Track (In
“Stop”) When selected, input monitoring is

turned off when a track is disarmed.
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Mute Record-Armed Tracks While Stopped This
setting determines monitor status of record-
armed tracks.

e When enabled, Pro Tools mutes tracks that
are record-enabled when the Transport is
stopped. Input can still be monitored while
stopped using the TrackInput button.

e When not enabled, Pro Tools monitors au-
dio input on tracks that are record-enabled.

Avid Video Errors Stop Playback If selected,
Pro Tools automatically stop playback of audio
and video if a single frame of video is dropped.

If unselected, Pro Tools continues playback of

audio even if frames are dropped. In most cases,
video playback will recover within a few frames
and continue playing audio and video in sync.

Numeric Keypad Mode

The Numeric Keypad mode determines how the
numeric keypad functions. You can always use
the numeric keypad to select and enter values in
the Event Edit Area, Location Indicators, and
Transport fields.

Classic Emulates the way Pro Tools worked in
versions earlier than 5.0. With the Numeric Key-
pad mode set to Classic, you can play up to two
tracks of audio in Shuttle Lock mode. Press Con-
trol (Macintosh) or the Start key (Windows), fol-
lowed by 0-9 for different play speeds. Press Plus
(+) or Minus (-) to reverse direction. Recall
Memory Locations by typing the Memory Loca-
tion number, followed by period (.).

62 Pro Tools Menus Guide

Transport Lets you set a number of record and
play functions, and also operate the Transport
from the numeric keypad. With the Numeric
Keypad mode set to Transport, you can play up
to two tracks of audio in Shuttle Lock mode.
Press Control (Macintosh) or the Start key (Win-
dows), followed by 0-9 for different play speeds.
Press Plus (+) or Minus (-) to reverse direction.
Recall Memory Locations by typing period (.),
the Memory Location number, and period (.)
again.

Shuttle Selects a type of shuttling different from
that of Shuttle Lock mode. With the Numeric
Keypad mode set to Shuttle, playback is trig-
gered by pressing and holding the keys on the
numeric keypad—playback stops once the keys
are released. Various playback speeds are avail-
able in both forward and reverse. You can also
recall Memory Locations by typing period (.),
the Memory Location number, and period (.)
again.

Autosave

This preference determines how the Autosave
feature functions.

Enable Session File Auto Backup When selected,
Pro Tools automatically saves backups of your
Pro Tools session file while you work. Backups
are saved to in the Session Files Backup folder in
your session folder. Use the Keep and Backup
Every fields to specify the total number of incre-
mental backups that are kept and how often the
session is saved.



Online Options

Record Online at Time Code (or ADAT)
Lock When selected, online recording begins as

soon as Pro Tools receives and locks to time
code or ADAT sync.

Record Online at Insertion/Selection When se-
lected, online recording begins at the Edit cursor
location. Recording continues until Pro Tools
stops receiving time code. If you make a selec-
tion, Pro Tools records online for the length of
the selection.

Open Ended Record Allocation Options

This preference determines how much of your
available hard drive space is allocated for record-
ing. Choices are:

Use All Available Space When selected, the
drive’s entire available space is allocated. This
can sometimes slow down the recording process
for hard drives that use certain file systems, in-
cluding HFS+ and NTEFS.

Limit To Sets the maximum allowable recording
duration. This can help reduce the time it takes
to begin recording by allocating only a portion
of your hard drive. The number of minutes spec-
ified is allocated for each record-enabled track.
You may find it necessary to experiment with
this number to achieve the desired performance
for recording.

QuickTime Playback Priority Options

Normal This is the default setting for QuickTime
Movie Playback Priority. It gives no extra prior-
ity to movie playback over other screen update
tasks such as metering, moving faders, and so
on. In most cases you should use this setting. If,
however, you are running QuickTime movies
without a video capture card, you may need to
use the Higher or Highest Playback Priority set-
ting.

Higher This command gives QuickTime movie
playback a higher priority relative to other

Pro Tools screen update tasks. This yields better
movie playback performance if you are running
QuickTime movies without a video capture
card.

Highest This command gives QuickTime movie
playback highest priority. In this mode,

Pro Tools disables screen activity such as meter-
ing during movie playback. This yields the high-
est movie playback performance if you are run-
ning QuickTime movies without a video capture
card.

Additional Options

Custom Shuttle Lock Speed Sets the highest fast-
forward Shuttle Lock speed (key 9) for Shuttle
Lock modes (Classic or Transport). The range for
this setting is 50-800%.

Calibration Reference Level (Pro Tools HD Only)

Sets a default calibration reference level in dB
when Pro Tools is in Calibration mode. For au-
dio interfaces that have physical trim controls
(such as the 192 I/O and 888|24 1/0), see the in-
terface’s guide for calibration instructions.

Auto Regions Fade In/Out Length Sets a default
length for fade-ins and fade-outs automatically
applied to region boundaries. Using automatic
fade-ins and fade-outs saves you the trouble of
editing to zero-crossings or creating numerous
rendered fades in order to eliminate clicks or
pops in playback. Autofades are not written to
disk. Value range is from 0-10 ms for the Auto
Region Fade In/Out Length. A value of zero
means that no auto-fading will occur. The Auto
Fade value is saved with the session, and is auto-
matically applied to all free-standing region
boundaries until you change it.
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Back/Forward Amount Sets the default length of
Back, Back and Play, Forward and Forward and
Play. The Back/Forward Amount defaults to fol-
low the main time scale, or Follow Main Time
can be unchecked and a specific timebase for-
mat can be selected: Bars:Beats, Min:Sec, Time
Code. Feet+Frames. or Samples

Solo Latch Options

This preference determines if solos are latched,
unlatched, or added temporarily (Pro Tools HD
only).

Latch When selected, pressing subsequent Solo
buttons does not cancel previously pressed so-
los.

Momentary (Pro Tools HD with Supported Control
Surfaces Only) When selected, the Solo button is

not sticky. When the Solo button is held down,
the track is soloed. Additional tracks can be so-
loed by touching their Solo buttons (as long as
at least one Solo button is held down). When no
Solo button is held down, all soloed tracks will
unsolo.

X-OR (Cancels Previous Solos) When selected,
pressing subsequent Solo buttons cancels previ-
ous solos.
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Editing Preferences
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Editing Preferences page

Recall Memory Location Selection at Original
Track When selected, Memory Locations that

recall a selection also recall the track in which
the selection was made.

Auto-Name Memory Locations When
Playing When selected, Pro Tools gives new

memory locations default names based on their
time location in the session. The time units cur-
rently chosen in the View menu determine the
units for the names.

Auto-Name Separated Regions When selected,
Pro Tools automatically names newly separated
regions by appending a number to the region’s
name. Disabling this option can be useful when
importing region groups, REX files, or ACID
files, because these file types can contain so
many separate regions that it becomes difficult
to read the Region List.



Region List Selection Follows Edit
Selection When selected, selecting a region in a

track also selects it in the Region List.

Edit Selection Follows Region List
Selection When selected, selecting a region in

the Region List causes Pro Tools to highlight
that region’s occurrence in a track.

Crossfade Preview Pre-Roll This option specifies
the amount of pre-roll to be added when you are
auditioning crossfades in the Fades dialog.

Crossfade Preview Post-Roll This option speci-
fies the amount of post-roll to be added when
you are auditioning crossfades in the Fades dia-
log.

Default Fade Settings

Fade In Selects the default envelope shape for
fade-ins.

Crossfade Selects the default envelope shape for
crossfades.

Fade Out Selects the default envelope shape for
fade-outs.

Conversion Quality Selects the sample rate con-
version quality. Sample rate conversion is used
in a variety of Pro Tools processes, including
converting and importing audio files of differ-
ent formats into a session, and bouncing and
saving tracks to a different sample rate or bit
depth. The higher the quality of sample rate
conversion you choose, the longer Pro Tools
will take to process the audio file.

“Matching Start Time” Takes List

Control-clicking (Windows) or Command-click-
ing (Macintosh) in a track displays a list of re-
gions whose time stamp matches the current
cursor location. The following options deter-
mine which takes appear in this list:

Take Region Name(s) That Match Track
Names When selected, only regions that share

the same root name with the track and playlist
appear in the Takes List pop-up menu.

Take Region Lengths That Match When selected,
only regions that match the length of the cur-
rent selection appear in the Takes List pop-up
menu.

“Separate Region” Operates On All Related
Takes When selected, editing a region with the

Separate Region command also affects all other
related takes with the same User Time Stamp.
This option helps you compare different sec-
tions from a group of related takes.

QuickPunch/TrackPunch Crossfade Length

This options lets you specify a default length for
crossfades created by QuickPunch and Track-
Punch recording. Crossfades occur before the
punch in and after the punch out.

Levels Of Undo

This option lets you set the maximum number
of actions (up to 32) that can be undone with
the multiple undo feature.
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Automation Preferences
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Automation Preferences page

Faders Move During Playback When selected,
faders move on-screen when automated. When
deselected, faders do not move, but automation
is still functioning.

Smooth and Thin Data After Pass When se-
lected, automation is automatically smoothed
and thinned by the amount specified with the
Degree of Thinning option.

Mutes Follow Groups When selected, muting a
track that belongs to a Mix group mutes all
other members of the group. When deselected,
tracks must be muted individually.

Solos Follow Groups When selected, soloing a
track that belongs to a Mix group solos all other
members of the group. When deselected, tracks
must be soloed individually.

Send Mutes Follow Groups When selected, mut-
ing a Send that belongs to a group mutes all
other members of the group. When deselected,
Sends must be muted individually.
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Send Levels Follow Groups When selected, ad-
justing the level of a Send that belongs to a
group adjusts the Send levels of all other mem-
bers of the group. When deselected, Send levels
must be adjusted individually.

LFEs Follow Groups When selected, adjusting or
editing an LFE (Low Frequency Effects) control
of a track or send that belongs to a Mix group
adjusts the LFE controls of all members of the
group. When deselected, LFE controls must be
adjusted individually.

After Write Pass, Switch To (Pro Tools HD Only)

Selects the Automation mode that Pro Tools
tracks automatically switch to after an automa-
tion pass in Write mode. You can choose to
switch to Touch or Latch mode, or stay in Write
mode by selecting No Change.

Q “The After Write Pass, Switch To” setting
" also affects Write/Trim mode. After a
Write/Trim automation pass, the
Write/Trim tracks automatically switch to
Latch/Trim, Touch/Trim, or remain in
Write/Trim.

Degree of Thinning Specifies the amount of thin-
ning performed on automation data when auto-
mation is recorded. Avoid over thinning auto-
mation data or it may no longer accurately
reflect the original pass.

Touch Timeout Specifies how quickly automa-
tion recording stops or “times out” after you
stop moving a control surface in Touch mode.

AutoMatch Time Specifies how quickly Pro Tools
returns a fader or other control to its previously
automated level after automation recording
stops.



AutoGlide Time Specifies the time it takes to
glide from point to point (from the Pan Loca-
tion cursor to the new destination), when using
AutoGlide mode in the Surround Panner.

Amount of Memory for Automation
Recording Lets you reserve additional memory

for recording automation. If you have dense au-
tomation data or a large number of automated
tracks, increase this amount. Relaunch

Pro Tools for this setting to take effect.

Processing Preferences

) Cemmmm ]

Processing Preferences page
AudioSuite Dither

Use AudioSuite Dither When selected, applies a
selectable dither plug-in to specific AudioSuite
processing tasks (such as Gain and Normalize).

Dither Plug-In Specifies the plug-in used for
dither processing when the Use AudioSuite
Dither option is selected.

Edit Settings When a Digidesign dithering plug-
in is used, allows you to apply either normal or
noise-shaping dither.

Bit Depth

16-, 18-, 20-, and 24-Bit Lets you select a bit
depth for the dithered audio.

AudioSuite Buffer Size

AudioSuite Buffer Size sets the size of the mem-
ory buffer used for audio processing and pre-
viewing with AudioSuite plug-ins. Generally,
choosing a smaller buffer speeds up AudioSuite
audio previewing functions. Choosing a larger
buffer speeds up AudioSuite processing func-
tions. Set the buffer according to your current
task. Before auditioning an AudioSuite plug-in,
set the buffer to Mini or Small. When you pro-
cess a file, set it to Large or Jumbo.

TC/E (Time Compression and Expansion)

TC/E Plug-In Allows you to choose the plug-in
used for Time Compression and Expansion
when you edit audio with the Time Trimmer
tool. The Time Trimmer works by using Time
Compression/Expansion to match an audio re-
gion to the length of another region, a tempo
grid, a video scene, or other reference point.

Default Settings Specifies the default settings
used by the chosen Time Compression/Expan-
sion plug-in.
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MIDI Preferences
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MIDI Preferences page

Default Note On Velocity Sets the default Note
On velocity for MIDI notes inserted in the Edit
window and the MIDI Event List.

Pencil Tool Resolution When Drawing Controller
Data Sets the default resolution for MIDI con-

troller data created with the Pencil. Setting this
to a lower resolution helps avoid creating con-
troller data that is unnecessarily dense. The
value range is from 1 to 100 milliseconds.

Global MIDI Playback Offset Sets an offset in
samples to compensate for MIDI latency. Enter-
ing a value here has the same effect as setting an
offset with the MIDI Track Offsets command
(Event > MIDI Track Offsets). Offset values can
be positive (later) or negative (earlier).

Default Thru Instrument Sets the default MIDI
Thru instrument. You can select a predefined
device from your available MIDI instruments, or
select “Follows First Selected MIDI Track” to use
the assigned MIDI output of the first selected
MIDI or Instrument track. When multiple MIDI
or Instrument tracks are selected, the instru-
ment in the selected track that is closest to the
top of the Edit window (or closest to the left
edge of the Mix window) will be used.
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General Section

Play MIDI Notes When Editing When selected,
causes MIDI notes to sound when you insert
them with the Pencil or drag them with the
Grabber.

Use MIDI to Tap Tempo When selected, lets you
use MIDI input to set tempo in Manual Tempo
mode.

Display Events as Modified by Real-Time Proper-
ties When selected, displays the effects of Real-

Time Properties in both the Edit window and the
MIDI Event List.

MIDI Note Display Options

Standard Pitch Sets the reference for middle C as
C3.

Alternate Pitch Sets the reference for middle C as
C4.

MIDI Note Number Sets the reference for middle
C as MIDI note number 60.

Delay for External Devices Options
(Pro Tools HD Only)

These options let you apply Delay Compensa-
tion to MIDI Time Code and MIDI Beat Clock
output by the system. Generally, this delay
should be applied when the output of the exter-
nal MIDI device is mixed externally, and not
when the output of the external device is mixed
back into Pro Tools.

These options are only available in the MIDI
Preferences page when a Delay Compensation
Engine is chosen in the Playback Engine Dialog
and Delay Compensation is enabled in

Pro Tools.



Machine Control Preferences
(Pro Tools HD Only)

Do

Machine Control Preferences page

Machine Chases Memory Location When se-
lected, navigating to a specific location in a ses-
sion with a Memory Location causes a con-
nected transport to chase to that location.

Machine Follows Edit Insertion/Scrub When se-
lected, navigating to a specific location in a ses-
sion by moving the selection point or by scrub-
bing a track will cause a connected transport to
chase to that location. Enabling Machine fol-
lows Edit Insertion/Scrub is only recommended
when slaving a non-linear device to Pro Tools.

Machine Cues Intelligently When selected, if you
navigate to a cue point that is more than 10 sec-
onds from the current location, Pro Tools will
command a connected transport to shuttle to
the desired location at full speed to within 10
seconds of the cue point. Cueing will then slow
to normal speed until the point is reached. This
significantly speeds up tape cueing.

Stop At Shuttle Speed Zero When selected,
Pro Tools sends a Stop command when shuttle
speed equals zero.

Delay Before Locking To LTC Sets a number of
frames of delay for Pro Tools to wait before at-
tempting to lock to Linear Time Code, to com-
pensate for the amount of time needed for the
master machine to stabilize. This setting can be
especially useful in a multi-machine environ-
ment.

Remote Mode

These settings affect Remote 9-Pin Deck Emula-
tion Mode only, which requires Machine-
Control™,

Punch In Frame Offset Sets an offset in frames to
compensate for punch in timing advances or de-
lays.

Punch Out Frame Offset Sets an offset in frames
to compensate for punch out timing advances
or delays.

Delay After Play Command Sets a number of
frames of delay for Pro Tools to wait before at-
tempting to lock, to compensate for the amount
of time needed for the master machine to stabi-
lize. This setting can be especially useful in a
multi-machine environment.

Ignore Track Arming Allows Pro Tools to respond
to all 9-pin remote commands except track arm-
ing. Requires the Pro Tools MachineControl op-
tion.

Set Servo Lock Bit at Play (Tamura Support) En-
able this option when using a Tamura synchro-
nizer to control Pro Tools in Remote mode to
minimize lock-up times during recording.
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Window Menu

Window Menu

The Window menu provides commands to tog-
gle the display of various Pro Tools windows: se-
lecting the command displays the window; se-
lecting the command again hides the window.

_Help M 4)) Thu 3:

+ Mix =
v Edit #W
Task Manager T |
Workspace N
Project N0
Browsers
Transport ¥@D
Big Counter ®3
Automation Enable 3£ (4]
Memory Locations #[E
Machine Track Arming 3£(6
Universe 36 (7]
QuickTime Movie 3 (g
Color Palette
Undo History
Disk Space
System Usage
—

Window menu

Q For Window menu items, keyboard short-
cuts with number keys only work using the
numeric keypad on your computer.

Mix

This command displays the Mix window, used
for recording and mixing tasks.

Edit

This command displays the Edit window, used
for graphical editing and arranging of audio,
MIDI and automation.

Task Manager

This command displays the Task Window, used
to monitor, pause, or cancel ongoing tasks.

Workspace

This command displays the Workspace browser,
which can be used for searching, sorting, audi-
tioning, and importing data. The Project, Vol-
ume, and Catalog (Pro Tools HD only) browsers
can be accessed from the Workspace browser.
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Project

This command displays the Project Browser,
used for Pro Tools file management with the
current session.

For more information on the Task window,
Workspace, Project, and other browsers, see
the DigiBase and DigiBase Pro Guide.

Browsers

Use the Browsers command to select a currently
open browser and bring it to the front. The
Browsers submenu can also be used to bring all
currently open browsers to the front, or send all
browsers to the back. Choices include Bring to
Front, and Send to Back.

Transport

This command opens the Transport window.
This window can display counters, MIDI con-
trols, and basic or expanded transport controls
(configure the Transport window from View >
Transport).

Transport window
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Big Counter

This command opens the Big Counter window.
This window provides a large, easy to see refer-
ence for the current session time location. Time
is displayed in the currently chosen Main Time
Scale format.

Big Counter window

Automation Enable

This command opens the Automation Enable
window. This window lets you enable or sus-
pend the writing of volume, pan, mute, plug-in,
send level, send pan, and send mute automation
for all tracks.

[5]

auto arm:

auto write on stop:
=3
start all  end
next

Automation Enable window (Pro Tools HD shown)

Before you can record automation, the desired
automation type must be enabled. Buttons are
highlighted when enabled. To suspend writing
of automation, deselect the button for the de-

sired automation type.



Memory Locations

This command opens the Memory Locations
window. Here you can store up to 200 time lo-
cation markers, selections, zoom settings, pre-
and post-roll times, track show and hide states,
track height states, and group enables. To recall
a memory location, click the button for the de-
sired location or, on your computer’s numeric
keypad, press the number of the location fol-
lowed by a period (.).
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Memory Locations window

Machine Track Arming

(Pro Tools HD with MachineControl Option
Only)

This command opens the Machine Track Arm-
ing window on systems that have the Machine-
Control option installed. When using Machine-
Control, this window lets you record-arm
external recording devices from within

Pro Tools.

Universe
(Pro Tools HD Only)

This command opens the Universe window.
This window provides a visual overview of all
tracks in a session. Use the Universe window to
quickly click and go to any location in a session.

Avid Video
(Pro Tools HD Only)

This command open the Video window, which
displays Avid Video imported into the current
session using the File > Import > Video com-
mand. The window provides a sample-accurate,
random-access reference for spotting sound ef-
fects, music, Foley, dialog, or other audio to the
Avid Video.

Video window

QuickTime Movie

This command opens the Movie window, which
displays QuickTime movies imported into the
current session using the File > Import > Quick-
Time Movie command. The window provides a
sample-accurate, random-access reference for
spotting sound effects, music, Foley, dialog, or
other audio to the QuickTime movie.

Color Palette

This command opens the Color Palette window.
Use this window to make color selections for
tracks, regions, groups and markers.
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Color Palette window
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Undo History

This command opens the Undo History win-
dow. Use this window to view a list of undoable
and redoable operations and return to any pre-
vious state. The Undo History can show editing
times, enabling you to revert to the state a ses-
sion held at a particular time.

A.0.8 Undo History

10:12:25 4 | Region Slide

10:12 36 &M | Draw Tempo Parabolic Curve

10:21 05 AM | HIDI Recording

10:31:51 AM | Pencil Note: C*3

103222 A | Oraw Temoe Line —
10:32:50 AP | Pencil Breskooeinds : Line
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—

Undo History window

Disk Space

This command opens the Disk Space window.
This window shows the recording capacity of
each hard drive attached to your system, mea-
sured in track minutes. This calculation is based
on the bit depth and sample rate of the current
session.

Disk | size | Avail | % [ 44.1kHz 16 Bit Track Min.
Classic  44G 774.2M 17.2% 153.4 Min
Main  14.7G  4.9G  33.4% 995.8 Min

Disk Space window
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System Usage

This command opens the System Usage win-
dow. This window provide meters that indicate
how much of your system’s processing power is
being used in processing audio, and when writ-
ing and playing back automation.

With Pro Tools LE, these meters show PCI bus
activity, CPU processing activity and Disk pro-
cessing activity.

With Pro Tools HD, these meters show Activity
(PCI bus activity, CPU processing activity, and
Disk processing activity) and TDM Time Slot us-
age.

000
Activity
PCI I
CPU I
Disk I
TDM Time Slots Used
30 of 512
HD Core #1

HD Engine I 100%

HD Accel #1

I
Plug-In Sharing [ 7

StereoMixerz4 RN 3 1%
Plug-In Sharing X 10%

System Usage window (Pro Tools HD shown)



The Help menu provides links to important
Pro Tools documentation, including Keyboard
Shortcuts, DigiBase Guide, DigiRack Plug-Ins
Guide, Pro Tools Menus Guide, Pro Tools Reference
Guide.

Select the title of the desired document from the
Pro Tools menu to launch the document in
Adobe Acrobat Reader (downloadable from
www.adobe.com).

9 = 4) Wed!

DigiBase Guide...

DigiRack Plug-Ins Guide...
Keyboard Shortcuts...
Digidesign FAQ...

Pro Tools Menus Guide...
Pro Tools Reference Guide...

Help menu
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Region List

Region List

The Edit Window displays all audio regions,
MIDI regions, and region groups in a single,
comprehensive Region List.

The pop-up menu at the top of the Region List
provides general menu commands and tools for
for managing the contents of the list.

= Find... {r3EF
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g.J Timeline Drop Order »

Region List pop-up menu

Find

Use the Find command to display all regions in
a list whose names contain a particular word or
phrase.

Clear Find

This command returns the Region List to dis-
playing regions as they were displayed before
the last Find.

Select Parent in Project Browser

When this command is enabled, the DigiBase
Project browser automatically highlights the
parent file of any file or region selected in the
Region List.

This setting is latching (meaning it maintains its
setting).

Chapter 13: Region List

77



Show Options

The Region List can show different types of re-

gions and region information. Select the Show

options for the items you want to show. You can
also deselect Show options to hide a type of re-
gion or region information to streamline the list
of region names.

Region Types

Audio Shows Audio regions in the Region List.
MIDI Shows MIDI regions in the Region List.
Grouped Shows regions that are part of a group.

Auto-Created Shows automatically-created re-
gions. These are regions that were created as a
by-product of cutting, pasting, and separating
other regions. Since these by-product regions
can become numerous, hiding them (by dese-
lecting the option) helps you to avoid scrolling
through an unnecessarily long Region List.

Region Information

Color Shows Track Color Coding as assigned
with Default Region Color Coding option in
Display Preferences page, or as assigned in the
Color Palette.

Icon Shows the Track Type icon for the region.
The icon refers to the type of track (audio, MID],
or Instrument) that the region is used on.

Timebase Shows whether regions are tick-based
or sample-based.

File Name Shows the audio file from which the
region originated.

Disk Name Shows the name of the hard drive on
which the region resides.

Full Path Shows the full directory path name of
the region’s location.

78 Pro Tools Menus Guide

Select Options

In the Region List, you can select specific re-
gions so they can be dragged to tracks, processed
with AudioSuite plug-ins, or exported.

All Selects all regions in the Region List.

Unused Selects regions that have not been
placed in a track in the current session. Offline
regions appear in the Region List as italicized
and dimmed.

Unused Except Whole Files Selects regions that
have not been placed in a track in the current
session, but do not include Whole-file regions.
Whole-file regions are regions that were created
when recording or importing audio, consolidat-
ing existing regions, and when nondestructively
processing with an AudioSuite plug-in. Whole-
file audio regions reference an entire audio file
that resides on your hard drive. Whole-file au-
dio regions are displayed in bold in the Region
List

Offline Selects regions whose parent files cannot
be located, or are not available, when opening a
session or importing a track. Offline regions ap-
pear in the Region List as italicized and dimmed;
they appear in playlists as light blue regions
with italicized names.



Sort By Options

The Sort By options let you sort regions to help
keep track of large numbers of regions.

Audio regions can be sorted by:
e Region Type
e Name
e Length
e Original Time Stamp
e User Time Stamp
e Timebase
e Start in Parent
e End in Parent
e File Name
e File Length
¢ File Creation Date
¢ File Modification Date
e Disk Name (audio and region groups only
e Track Format/Width

MIDI regions can be sorted by:
e Name, Length
e Original Time Stamp
e User Time Stamp
e Timebase
¢ Start in Parent

¢ End in Parent.

Regions can also be sorted by Region Type (Au-
dio and MIDI), or in Ascending or Descending
order.

Clear

This command lets you remove unwanted re-
gions from the session. Whole-file regions can
also be removed permanently from your hard
drive.

A Clearing whole-file regions is destructive
and cannot be undone. It permanently re-
moves the file from your hard drive. There is
no way to recover files deleted with this
command.

Rename

This command lets you rename selected regions.

When you rename a whole-file audio region,
you can specify whether to rename just the re-
gion, or both the region and the disk file.

Auto Rename

This command lets you specify the auto-naming
options for a region when new regions are cre-
ated from it in the course of editing.

Auto-naming of regions does not affect the
names of parent audio files. Instead, it stores
pointers to the regions within the parent source
file.

The Auto Rename command opens a dialog
with the following fields:

Name Determines the root name for the auto-
created regions.

Number Sets the start number for the sequen-
tially numbered new regions.

Zeros Determines the number of zeros that oc-
cur before the auto numbers.

Suffix Specifies text to be appended to the end of
the name, following the auto numbering.
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Time Stamp

This command lets you select a region (or re-
gions) and redefine its SMPTE time stamp. The
Original Time Stamp and the User-Time Stamp
are then stored with your session.

When audio is first recorded, the User Time
Stamp will match the Original Time Stamp, but
you can change the User Time Stamp at any
time using the Time Stamp command. This fea-
ture is particularly useful in post production sit-
uations where the SMPTE time code on video
“work prints” often changes from one edit revi-
sion to another.

Replace Region
(Pro Tools HD Only)

This command opens a dialog that lets you re-

place multiple instances of an audio region in a
playlist with another region that you Control-

drag (Windows) or Command-drag (Macintosh)
from the Region List.

The Replace Region function only works on a se-
lection that includes a single region on one
track. The function is not available when the
playlist selection includes the start points for
two or more regions. Also, if the selection is
across several tracks, only the selection in the
first (top) track is used.
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Compact

The Compact command deletes unused por-
tions of audio files to conserve disk space, and to
prepare for cleaner hard drive back-ups. The
Compact command also deletes audio if there
are no regions referencing the data.

A\ The Compact command is destructive and
cannot be undone. It permanently alters the
original audio files. There is no way to re-
cover data deleted with this command.

Because it permanently deletes audio data, the
Compact command should be used only after
you have completely finished your editing and
are sure that you have no further use for the un-
used audio data.

The Compact Selected command can pad the re-
gions of the compacted file by a user-selectable
amount. You may want to do this because

Pro Tools requires extra audio data before and
after audio regions to create crossfades. So, if
your regions have crossfades, or if you want to
pad the regions for the sake of any future trim-
ming, you should enter an appropriate amount
of padding (in milliseconds) to allow for this.

Export Region Definitions

This command lets you export region defini-
tions for audio files within each session, so that
you can use an audio file’s regions in another
session, or with another application that sup-
ports them.

The Export Region Definitions command does
not export regions as audio files (unlike the Ex-
port Regions as Files command). Instead, it
stores pointers to the regions within the parent
source file.



Export Regions as Files

This command lets you export regions as audio
files. Use this command if you intend to use a re-
gion in other sessions (or other audio applica-
tions) without using its parent source file.

This command also provides a way to convert
regions to a different audio format, sample rate,
or bit depth.

Export Region Groups

This command lets you export region groups as
files. Use this command if you intend to use a re-
gion group in other sessions.

If you are exporting region groups to another
hard drive, you may want to copy any refer-
enced audio files as well. This way you can move
region groups not only from one session to an-
other, but from one system to another.

Recalculate Waveform Overviews

This command re-creates the session’s wave-
form overview data (the data used to create
waveform displays). Use this command if you
think overview data for a session has become
corrupted, or if you import audio files which
have no overview data into a session.

Recalculating waveform overviews may take
some time if there are many tracks in the ses-
sion.

Timeline Drop Order

This command sets whether tracks dragged from
the Region List are dropped sequentially in a
single track or spread across multiple tracks.

Top to Bottom When enabled, regions are spread
across multiple destination (drop) tracks, or on
new tracks (when dragging to the area below the
last track or to the Track List).

Left to Right When enabled, regions are placed
sequentially in a single destination (drop) track
or a newly created track (when dragging to the
area below the last track or to the Track List).

Chapter 13: Region List
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